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C H A P T E R 3

Turn Up a Node

This chapter explains how to provision a single Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) node and turn it up for service, including assigning the node name, date, and 
time; provisioning timing references; provisioning network attributes such as IP address and default 
router; setting up users and user security; installing cards; and creating DWDM connections.

Note Procedures in this chapter require that you have a network plan calculated for your DWDM network with 
Cisco TransportPlanner, Release 8.5. Cisco TransportPlanner is a DWDM planning tool that is available 
from your Cisco account representative. Cisco TransportPlanner prepares a shelf plan for each network 
node and calculates the power and attenuation levels for the DWDM cards installed in the node. For 
information about Cisco TransportPlanner, contact your Cisco account representative. For instructions 
on using Cisco TransportPlanner, refer to the Cisco TransportPlanner DWDM Operations Guide, 
Release 8.5.

Note Unless otherwise specified, in this document “ONS 15454” refers to both ANSI (ONS 15454) and ETSI 
(ONS 15454 SDH) shelf assemblies.

Note Cisco Transport Controller (CTC) views referenced in these procedures depend on the ONS 15454 mode. 
In single-shelf mode, the views are network, node, and card. In multishelf mode, the views are network, 
multishelf, shelf, and card. For more information about CTC views, refer to Appendix A, “CTC 
Information and Shortcuts.”

Before You Begin
This section lists the non-trouble procedures (NTPs) needed to turn up a DWDM node. Turn to an NTP 
for applicable detail-level procedures (DLPs), known as tasks.

1. NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3—Complete this procedure 
first.

2. NTP-G22 Verify Common Card Installation, page 3-5—Complete this procedure next.

3. NTP-G144 Provision a Multishelf Node, page 3-6—Complete this procedure as needed.

4. NTP-G23 Create Users and Assign Security, page 3-7—Complete this procedure to create CTC 
users and assign their security levels.
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5. NTP-G24 Set Up Name, Date, Time, and Contact Information, page 3-10—Continue with this 
procedure to set the node name, date, time, location, and contact information.

6. NTP-G25 Set Battery Power Monitor Thresholds, page 3-12—Continue with this procedure to set 
the node battery power thresholds.

7. NTP-G26 Set Up CTC Network Access, page 3-13—Continue with this procedure to provision the 
IP address, default router, subnet mask, and other network configuration settings.

8. NTP-G194 Set Up EMS Access to the ONS 15454, page 3-26—Continue with this procedure to 
connect the CTC in secure mode.

9. NTP-G341 Set Up Secure Access to the ONS 15454 TL1, page 3-27—Continue with this procedure 
to enable secure access to TL1.

10. NTP-G27 Set Up the ONS 15454 for Firewall Access, page 3-27—Continue with this procedure if 
the ONS 15454 will be accessed behind firewalls.

11. NTP-G132 Provision OSI, page 3-31—Continue with this procedure if the ONS 15454 will be 
installed in networks with third-party, Open Systems Interconnection (OSI)-based network elements 
(NEs).

12. NTP-G28 Set Up SNMP, page 3-41—Complete this procedure if Simple Network Management 
Protocol (SNMP) will be used for network monitoring.

13. “NTP-G143 Import the Cisco TransportPlanner NE Update Configuration File” procedure on 
page 3-43—Complete this procedure to preprovision the ONS 15454 slots and install the card and 
automatic node setup (ANS) parameters.

14. NTP-G30 Install the DWDM Cards, page 3-54—Complete this procedure to install the DWDM 
cards, including the OSCM, OSC-CSM, 32WSS, 32WSS-L, 40-WSS-C, 40-WSS-CE, 40-WXC-C, 
OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, OPT-PRE, 
32MUX-O, 40-MUX-C, 32DMX-O, 32DMX, 32DMX-L, 40-DMX-C, 40-DMX-CE, 4MD-xx.x, 
AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, and MMU.

15. NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-58—Complete this procedure, 
as needed, to install a dispersion compensating unit (DCU).

16. NTP-G179 Install the TXP, MXP, GE_XP, 10GE_XP, and ADM-10G Cards, page 3-59—Complete 
this procedure, as needed, to install transponder (TXP), muxponder (MXP), GE_XP, 10GE_XP, or 
ADM-10G cards.

17. NTP-G123 Install the Filler Cards, page 3-65—Complete this procedure, as needed, to install 
ONS 15454 filler cards.

18. NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 3-66—Complete this 
procedure, as needed, to install the fiber-optic cables on the DWDM cards.

19. NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes, page 
3-72—Complete this procedure, as needed, to connect TXP, MXP, GE_XP, 10GE_XP, or ADM-10G 
cards to DWDM cards in a terminal, hub, or reconfigurable optical add-drop multiplexer (ROADM) 
node through the patch panel.

20. NTP-G185 Install Fiber-Optic Cables between Mesh Nodes, page 3-87—Complete this procedure, 
as needed, to connect 40-WXC-C cards in a mesh node to the 4-degree or 8-degree patch panel.

21. NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection Modules, page 3-93—Complete this 
procedure, as needed, to connect fiber-optic cables to Y-cable modules from client TXP, MXP, 
GE_XP and 10GE_XP cards.

22. NTP-G152 Create and Verify Internal Patchcords, page 3-98—Complete this procedure to calculate 
the DWDM cable connections.
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23. NTP-G209 Create, Edit, and Delete Optical Sides, page 3-102—Complete this procedure to create, 
edit, and delete an optical side.

24. NTP-G38 Provision OSC Terminations, page 3-105—Complete this procedure next.

25. NTP-G37 Run Automatic Node Setup, page 3-108—Complete this procedure next.

26. NTP-G39 Verify OSCM Transmit Power, page 3-109—Complete this procedure next.

27. NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf Mode, page 3-112—Complete this 
procedure as needed.

NTP-G139 Verify Cisco TransportPlanner Reports and Files

Step 1 Verify that you have the Cisco TransportPlanner reports and files shown in Table 3-1 for the node that 
you will provision. The reports and files can be provided in one of the following ways:

• If you have Cisco TransportPlanner, verify that you have the electronic network design plan from 
which you can generate the reports in Cisco TransportPlanner. For information about generating the 
reports, refer to the Cisco TransportPlanner DWDM Operations Guide. 

• If you do not have Cisco TransportPlanner, you must have printouts of all reports listed in Table 3-1 
except the Assisted Configuration Setup file. Assisted Configuration Setup is an electronic file that 
will be imported into CTC. You must be able to access it from the CTC computer used to provision 
the node.

Purpose This procedure verifies that you have the Cisco TransportPlanner reports 
and files needed to turn up the node.

Tools/Equipment None

Prerequisite Procedures Chapter 1, “Install the Shelf and Common Control Cards”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Retrieve or higher

Table 3-1 Cisco TransportPlanner Node Setup Information and Files

Source Format Description

Shelf layout JPG file Cisco TransportPlanner provides a shelf layout (Figure 3-1) 
showing the cards that should be installed in each ONS 15454 
slot. Cisco TransportPlanner can export this as a JPG file with 
a user-defined name. 

Installation Parameters Table Provides the target reference values for the variable optical 
attenuators (VOAs), output power, optical thresholds, and 
amplifier configuration parameters.

Internal Connections Table Identifies the patchcords that must be installed within the shelf.
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Figure 3-1 Cisco TransportPlanner Shelf Layout

If you not do not have all the reports and files listed in Table 3-1, do not continue. See your site or 
network planner for the required information and files.

Step 2 Print Table 3-1 for reference. You will need information from the reports during node turn-up.

Stop. You have completed this procedure.

NE Update 
Configuration file

XML file The Cisco TransportPlanner NE Update configuration file is an 
electronic file with an XML extension and a name assigned by 
the network designer for the network you are provisioning. The 
file is imported into CTC where it preprovisions the shelf and 
configures the following card parameters: OTN and FEC 
parameters for TXP, MXP, GE_XP, 10GE_XP, ADM-10G 
cards, card mode for OPT-AMP-L, OPT-AMP-17-C, 
OPT-AMP-C, GE_XP, and 10GE_XP cards. It also provisions 
the OCH trunk to OCH filter internal patchcords, the optical 
sides. and it configures the ANS parameters based on the 
network calculated by Cisco TransportPlanner.

Traffic Matrix Table Shows the traffic flow within the node. During node turn-up, 
this report is used to identify the location of Y-cable protection 
groups.

Cable list Table or list A list of cables needed to provision the node. The list can be 
derived from the Internal Connections Report or from the Bill 
of Materials report prepared by Cisco TransportPlanner.

Table 3-1 Cisco TransportPlanner Node Setup Information and Files (continued)

Source Format Description
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NTP-G22 Verify Common Card Installation

Step 1 Verify that two TCC2 cards or two TCC2P cards are installed in Slots 7 and 11.

Step 2 Verify that the FAIL LED is off on both TCC2/TCC2P cards. 

Step 3 Verify that the green ACT (active) LED is illuminated on one TCC2/TCC2P card and that the amber 
STBY (standby) LED is illuminated on the other TCC2/TCC2P card. 

Note If the TCC2/TCC2P cards are not installed, or if their LEDs are not operating as described, do 
not continue. Complete the “DLP-G33 Install the TCC2 or TCC2P Card” task on page 1-77 or 
refer to the Cisco ONS 15454 DWDM Troubleshooting Guide to resolve installation problems 
before proceeding to Step 4.

Step 4 If the AIC-I card is installed, verify that it is installed in Slot 9 and that its ACT (active) LED displays 
a solid green light.

Note If the AIC-I card is not installed and the card is required by the Cisco TransportPlanner shelf 
layout, or if it is installed and its LEDs are not operating as described, do not continue. Complete 
the “DLP-G34 Install the AIC-I Card” task on page 1-80 or refer to the Cisco ONS 15454 
DWDM Troubleshooting Guide to resolve installation problems before proceeding to Step 5.

Step 5 Verify that the software release shown on the LCD matches the software release required for your 
network. On the LCD, the software release is shown under the platform (SONET or SDH) and 
date/temperature. If the release does not match, perform one of the following procedures:

• Perform a software upgrade using a Cisco ONS 15454 software CD or Cisco ONS 15454 SDH 
software CD. Refer to the release-specific software upgrade document.

• Replace the TCC2/TCC2P cards with cards containing the correct release.

Step 6 If the node will be configured as a multishelf node, verify that redundant MS-ISC-100T cards are 
installed (Slots 6 and 12 are recommended) and that the green ACT (active) LED is illuminated on both 
cards. 

Note If the MS-ISC-100T card is not installed and the card is required by the Cisco TransportPlanner 
shelf layout, or if the card’s LEDs are not operating as described, do not continue. Complete the 
“DLP-G309 Install the MS-ISC-100T Card” task on page 1-81 or refer to the Cisco ONS 15454 
DWDM Troubleshooting Guide to resolve installation problems before proceeding to the next 
procedure.

Purpose This procedure verifies that the ONS 15454 node has two TCC2 or TCC2P 
cards installed. It also verifies the installation of the AIC-I and 
MS-ISC-100T cards, if they are installed.

Tools/Equipment None

Prerequisite Procedures Chapter 1, “Install the Shelf and Common Control Cards”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Retrieve or higher
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Stop. You have completed this procedure.

NTP-G144 Provision a Multishelf Node

Caution An optical shelf in a multishelf configuration must be provisioned as the node controller shelf and not a 
subtending shelf. Otherwise, traffic will be dropped. If no slots are available on an optical shelf to install 
the MS-ISC-100T cards needed for a node controller shelf, install and configure the Cisco Catalyst 2950. 
See the “NTP-G158 Connect a Multishelf Node and Subtending Shelves to a Catalyst 2950” procedure 
on page 1-85.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node that you want to configure as a 
multishelf node.

Step 2 If you want to set up the login node as the node controller, complete the following steps. If not, continue 
with Step 3.

a. In node view (single-node mode) or multishelf view (multishelf mode), click the Provisioning > 
General > Multishelf Config tabs.

b. Click Enable as Node Controller. 

c. From the LAN Config drop-down list, complete one of the following:

• Choose Ethernet Switch if MS-ISC-100T cards or the Catalyst 2950 switches are already 
installed and configured.

• Choose Stand-Alone if MS-ISC-100T cards are not installed yet but will be included in the final 
layout. This option will allow a safe migration of the TCC2/TCC2P card database when the 
multishelf configuration is complete. 

d. Click Apply.

e. In the confirmation dialog box, click Yes to allow the node to reboot. The CTC view changes to 
network view and the node icon changes to gray. Wait for the reboot to finish. (This might take 
several minutes.) 

f. After the node reboots, double-click the node. The multishelf view appears.

Purpose This procedure provisions a multishelf node from CTC. A multishelf node 
consists of a control node and subtending shelves that are configured to 
operate as a single node.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

NTP-G145 Connect a Multishelf Node and Subtending Shelves to an 
MS-ISC-100T Card, page 1-82 or 

NTP-G158 Connect a Multishelf Node and Subtending Shelves to a 
Catalyst 2950, page 1-85

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note The shelf ID of the node controller is automatically assigned as 1.

Step 3 If you want to add a node as a subtending shelf in the multishelf configuration, complete the following 
steps. If not, you have completed this procedure.

a. In multishelf view, right-click the white space in the rack and choose Add Shelf from the shortcut 
menu.

b. In the Shelf ID Selection dialog box, choose a shelf ID (from 2 to 8) from the drop-down list. 

c. Click OK. The shelf appears in multishelf view.

d. Disconnect the cross-over (CAT-5) LAN cable from the RJ-45 LAN (TCP/IP) port of the subtending 
shelf TCC2/TCC2P card in Slot 11.

e. Connect your Windows PC or Solaris workstation network interface card (NIC) to the RJ-45 LAN 
(TCP/IP) port on the TCC2/TCC2P card in Slot 11.

f. Complete the “DLP-G46 Log into CTC” task on page 2-26 at the subtending shelf.

g. Click the Provisioning > General > Multishelf Config tabs.

h. Click Enable as Subtended Shelf. 

i. From the Shelf ID drop-down list, choose the shelf ID that you created in Step b.

j. Click Apply. 

k. In the confirmation dialog box, click Yes to reboot the shelf. The CTC view changes to network view 
and the node icon changes to gray. Wait for the reboot to finish. (This might take several minutes.) 

l. Disconnect your Windows PC or Solaris workstation NIC from the RJ-45 LAN (TCP/IP) port of the 
subtending shelf TCC2/TCC2P card in Slot 11.

m. Reconnect the cross-over (CAT-5) LAN cable (disconnected in Step d) to the RJ-45 LAN (TCP/IP) 
port of the subtending shelf TCC2/TCC2P card in Slot 11.

n. Repeat Steps a through m to set up additional subtending shelves.

Step 4 Complete “NTP-G145 Connect a Multishelf Node and Subtending Shelves to an MS-ISC-100T Card” 
task on page 1-82 to discover shelves and configure them as a multi-shelf mode.

Note Non-LAN connected Multishelf nodes are not manageable from CTC unless SOCKS Proxy is 
enabled on the node. 

Stop. You have completed this procedure.

NTP-G23 Create Users and Assign Security

Purpose This procedure creates ONS 15454 users and assigns their security levels.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

Required/As Needed As needed
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you need to create users. 
If you are already logged in, continue with Step 2.

Note You must log in as a Superuser to create additional users. The CISCO15 user provided with each 
ONS 15454 can be used to set up other ONS 15454 users. You can add up to 500 users to one 
ONS 15454.

Step 2 Complete the “DLP-G54 Create a New User on a Single Node” task on page 3-8 or the “DLP-G55 Create 
a New User on Multiple Nodes” task on page 3-9 as needed.

Note You must add the same user name and password to each node that a user will access.

Step 3 If you want to modify the security policy settings, including password aging and idle user timeout 
policies, complete the “NTP-G88 Modify Users and Change Security” procedure on page 10-51.

Stop. You have completed this procedure.

DLP-G54 Create a New User on a Single Node

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Security > Users tabs.

Step 2 In the Users window, click Create.

Step 3 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of six and a maximum of 
20 alphanumeric (a-z, A-Z, 0-9) characters. For Transaction Language One (TL1) compatibility, the 
user name must be 6 to 10 characters.

• Password—Type the user password. The password length, by default, is set to a minimum of six and 
a maximum of 20 characters. You can configure the default values in node view using the 
Provisioning > NE Defaults > Node > security > passwordComplexity tabs. The minimum length 
can be set to eight, ten or twelve characters, and the maximum length to 80 characters. The password 
must be a combination of alphanumeric (a-z, A-Z, 0-9) and special (+, #,%) characters, where at 
least two characters are not alphabetic and at least one character is a special character. For TL1 
compatibility, the password must be six to ten characters. 

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task creates a new user for one ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note The password must not contain the user name.

• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. 

Note Each security level has a different idle time. The idle time is the length of time that CTC can 
remain idle before the password must be reentered. The defaults are: Retrieve user = unlimited, 
Maintenance user = 60 minutes, Provisioning user = 30 minutes, and Superuser = 15 minutes. 
To change the idle times, see the “NTP-G88 Modify Users and Change Security” procedure on 
page 10-51.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

DLP-G55 Create a New User on Multiple Nodes

Note All nodes where you want to add users must be accessible in network view.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Security > Users tabs.

Step 3 In the Users window, click Create.

Step 4 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of six and a maximum of 
20 alphanumeric (a-z, A-Z, 0-9) characters. For TL1 compatibility, the user name must be 
6 to 10 characters.

• Password—Type the user password. The password length, by default, is set to a minimum of six and 
a maximum of 20 characters. You can configure the default values in node view through 
Provisioning > NE Defaults > Node > security > passwordComplexity. The minimum length can be 
set to eight, ten or twelve characters, and the maximum length to 80 characters. The password must 
be a combination of alphanumeric (a-z, A-Z, 0-9) and special (+, #, %) characters, where at least 
two characters are not alphabetic and at least one character is a special character. For TL1 
compatibility, the password must be six to ten characters. The password must not contain the user 
name.

Purpose This task adds a new user to multiple ONS 15454 nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. 

Note Each security level has a different idle time. The idle time is the length of time that CTC can 
remain idle before it locks up and the password must be reentered. The defaults are: Retrieve 
user = unlimited, Maintenance user = 60 minutes, Provisioning user = 30 minutes, and 
Superuser = 15 minutes. To change the idle times, refer to the “NTP-G88 Modify Users and 
Change Security” procedure on page 10-51.

Step 5 In the Select Applicable Nodes area, deselect any nodes where you do not want to add the user (all 
network nodes are selected by default).

Step 6 Click OK.

Step 7 In the User Creation Results dialog box, verify that the user was added to all the nodes chosen in Step 5. 
If not, click OK and repeat Steps 2 through 6. If the user was added to all nodes, click OK and continue 
with the next step.

Step 8 Return to your originating procedure (NTP).

NTP-G24 Set Up Name, Date, Time, and Contact Information

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 for the node you will turn up. If you are 
already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
General > General tabs.

Step 3 In the Node Name field, type a name for the node. For TL1 compliance, names must begin with an alpha 
character and have no more than 20 alphanumeric (a-z, A-Z, 0-9) characters.

Note To avoid errors when you import the Cisco TransportPlanner configuration file using the 
“NTP-G143 Import the Cisco TransportPlanner NE Update Configuration File” procedure on 
page 3-43, the CTC node name and the Cisco TransportPlanner site name should be the same (or 
at least easy to identify).

Purpose This procedure provisions identification information for the node, 
including the node name, a contact name and phone number, the location 
of the node, and the date, time, and time zone. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 (Optional) In the Contact field, type the name of the node contact person and the phone number, up to 
255 characters.

Step 5 (Optional) In the Latitude field, enter the node latitude: N (north) or S (south), degrees, and minutes.

Step 6 (Optional) In the Longitude field, enter the node longitude: E (east) or W (west), degrees, and minutes.

Note The latitude and longitude values only indicate the geographical position of the nodes in the 
actual network and not the CTC node position. 

Step 7 (Optional) In the Description field, type a description of the node. The description can be a maximum 
of 255 characters. 

Step 8 (Optional) Check the Use NTP/SNTP Server check box if you want CTC to use a Network Time Protocol 
(NTP) or Simple Network Time Protocol (SNTP) server to set the date and time of the node. Using an 
NTP or SNTP server ensures that all ONS 15454 network nodes use the same date and time reference. 
The server synchronizes the node’s time after power outages or software upgrades.

a. If you check the Use NTP/SNTP Server check box, type the IP address of one of the following:

– An NTP/SNTP server connected to the ONS 15454

– Another ONS 15454 with NTP/SNTP enabled that is connected to the ONS 15454

Note If you plan to check gateway network element (GNE) for the ONS 15454 SOCKS proxy 
server (see “DLP-G56 Provision IP Settings” task on page 3-14), external ONS 15454 nodes 
must reference the gateway ONS 15454 for NTP/SNTP timing. For more information about 
the ONS 15454 gateway settings, refer to the “Management Network Connectivity” chapter 
in the Cisco ONS 15454 DWDM Reference Manual.

Caution If you reference another ONS 15454 for the NTP/SNTP server, make sure that the second ONS 15454 
references an NTP/SNTP server and not the first ONS 15454 (that is, do not create an NTP/SNTP timing 
loop by having two ONS 15454 nodes reference each other).

b. If you do not check Use SNTP/NTP Server, complete the Date and Time fields. The ONS 15454 will 
use these fields for alarm dates and times. By default, CTC displays all alarms in the CTC computer 
time zone for consistency. To change the display to the node time zone, complete the “DLP-G118 
Display Alarms and Conditions Using Time Zone” task on page 9-12.

• Date—Type the current date in the format m/d/yyyy, for example, September 24, 2002 is 
9/24/2002.

• Time—Type the current time in the format hh:mm:ss, for example, 11:24:58. The ONS 15454 
uses a 24-hour clock, so 10:00 PM is entered as 22:00:00.

Step 9 Click the Time Zone field and choose a city within your time zone from the drop-down list. The list 
displays the 80 World Time Zones from –11 through 0 (GMT) to +14. Continental United States time 
zones are GMT-05:00 (Eastern), GMT-06:00 (Central), GMT-07:00 (Mountain), and GMT-08:00 
(Pacific).

Step 10 Check the Use Daylight Savings Time check box if the time zone that you chose uses Daylight Savings 
Time.

Note The Insert AIS-V on STS-1 SD-P and SD-P BER field are not used in DWDM networks.
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Step 11 Click Apply.

Step 12 In the confirmation dialog box, click Yes.

Step 13 Review the node information. If you need to make corrections, repeat Steps 3 through 12 to enter the 
corrections. If the information is correct, continue with the “NTP-G25 Set Battery Power Monitor 
Thresholds” procedure on page 3-12.

Stop. You have completed this procedure.

NTP-G25 Set Battery Power Monitor Thresholds

Caution The default battery power thresholds are normally not changed. Threshold changes should only be 
performed at the direction of your site administrator.

Note When the thresholds are crossed, the TCC2/TCC2P card generates warning alarms in CTC. For 
ONS 15454 power specifications, see the “Hardware Specifications” appendix in the Cisco ONS 15454 
DWDM Reference Manual.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 for the node that you will set up. If you are 
already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > General > 
Power Monitor tabs.

Note In multishelf mode, power monitor thresholds must be provisioned separately for each shelf 
within the multishelf including the node controller and all subtending shelves.

Step 3 To change the extreme low battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
ELWBATVGVdc drop-down list.

Step 4 To change the low battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
LWBATVGVdc drop-down list.

Step 5 To change the high battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
HIBATVGVdc drop-down list.

Step 6 To change the extreme high battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
EHIBATVGVdc drop-down list.

Purpose This procedure provisions extreme high, high, low, and extreme low input 
battery power thresholds within a –48 VDC environment. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 Click Apply.

Stop. You have completed this procedure.

NTP-G26 Set Up CTC Network Access

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “DLP-G56 Provision IP Settings” task on page 3-14 to provision the ONS 15454 IP 
address, subnet mask, default router, DHCP server, IIOP listener port, and SOCKS proxy server settings. 

Tip If you cannot log into the node, you can change its IP address, default router, and network mask 
by using the LCD on the ONS 15454 fan-tray assembly (unless LCD provisioning is 
suppressed). See the “DLP-G57 Set the IP Address, Default Router, and Network Mask Using 
the LCD” task on page 3-18 for instructions. However, you cannot use the LCD to provision any 
other network settings.

Note When accessing CTC from a machine running Windows XP operating system, CTC may 
sometimes fail to reconnect to a GNE when the GNE proxies for several ENE nodes 
(approximately 15 ENE nodes). This can happen when there is a side switch or when the LAN 
is enabled/disabled. This is due to the Windows XP operating system limiting the number of 
simultaneous TCP/IP connection attempts. As a workaround, relaunch CTC on the GNE node. 
You can configure a designated socks server list on the CTC to mitigate the problem.

Step 3 If TCC2P cards are installed and you want to turn on the ONS 15454 secure mode, which allows two IP 
addresses to be provisioned for the node, complete the “DLP-G264 Enable Secure Mode” task on 
page 3-20. Secure mode is not available if TCC2 cards are installed.

Step 4 If static routes are needed, complete the “DLP-G58 Create a Static Route” task on page 3-22. For more 
information about static routes, refer to the “Management Network Connectivity” chapter in the 
Cisco ONS 15454 DWDM Reference Manual. 

Purpose This procedure provisions network access for a node, including its subnet 
mask, default router, Dynamic Host Configuration Protocol (DHCP) 
server, Internet Inter-Orb Protocol (IIOP) listener port, gateway settings, 
static routes, Open Shortest Path First (OSPF) protocol, Routing 
Information Protocol (RIP), and designated SOCKS servers.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 5 If the ONS 15454 is connected to a LAN or WAN that uses OSPF and you want to share routing 
information between the LAN or WAN and the ONS network, complete the “DLP-G59 Set Up or Change 
Open Shortest Path First Protocol” task on page 3-23.

Step 6 If the ONS 15454 is connected to a LAN or WAN that uses RIP, complete the “DLP-G60 Set Up or 
Change Routing Information Protocol” task on page 3-25.

Step 7 Complete the “DLP-G439 Provision the Designated SOCKS Servers” task on page 3-17 after the 
network is provisioned and one or more of the following conditions exist:

• SOCKS proxy is enabled.

• The ratio of ENEs to GNEs is greater than eight to one.

• Most ENEs do not have LAN connectivity.

Stop. You have completed this procedure.

DLP-G56 Provision IP Settings

Caution All network changes should be approved by your network (or LAN) administrator.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > General tabs.

Step 2 Complete the following information in the fields listed:

• IP Address—Type the IP address assigned to the ONS 15454 node.

Note If TCC2P cards are installed, dual IP addressing is available using the secure mode. When 
secure mode is off (sometimes called repeater mode), the IP address entered in the IP 
Address field applies to the ONS 15454 backplane LAN port and the TCC2P TCP/IP (LAN) 
port. When secure mode is on, the IP Address field shows the address assigned to the TCC2P 
TCP/IP (LAN) port and the Superuser can enable or disable display of the backplane IP 
address. See the “DLP-G264 Enable Secure Mode” task on page 3-20 as needed. Refer to 
the “Management Network Connectivity” chapter in the Cisco ONS 15454 DWDM 
Reference Manual for more information about secure mode.

• Net/Subnet Mask Length—Type the subnet mask length (decimal number representing the subnet 
mask length in bits) or click the arrows to adjust the subnet mask length. The subnet mask length is 
the same for all ONS 15454 nodes in the same subnet.

Purpose This task provisions IP settings, which includes the IP address, default 
router, DHCP access, firewall access, and SOCKS proxy server settings for 
an ONS 15454 node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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• MAC Address—(Display only) Displays the ONS 15454 IEEE 802 MAC address.

Note In secure mode, the front and back TCP/IP (LAN) ports are assigned different MAC 
addresses, and the backplane information can be hidden or revealed by a Superuser.

• Default Router—If the ONS 15454 is connected to a LAN, enter the IP address of the default router. 
The default router forwards packets to network devices that the ONS 15454 cannot directly access. 
This field is ignored if any of the following are true:

– The ONS 15454 is not connected to a LAN.

– The SOCKS proxy server is enabled and the ONS 15454 is provisioned as an end network 
element (ENE).

– OSPF is enabled on both the ONS 15454 and the LAN where the ONS 15454 is connected. 
(OSPF is provisioned in the “DLP-G59 Set Up or Change Open Shortest Path First Protocol” 
task on page 3-23.)

• LCD IP Setting—Choose one of the following:

– Allow Configuration—Displays the node IP address on the LCD and allows users to change 
the IP settings using the LCD. This option enables the “DLP-G57 Set the IP Address, Default 
Router, and Network Mask Using the LCD” task on page 3-18.

– Display Only—Displays the node IP address on the LCD but does not allow users to change the 
IP settings using the LCD.

– Suppress Display—Suppresses the node IP address display on the LCD.

• Suppress CTC IP Display—Check this check box if you want to prevent the node IP address from 
appearing in CTC to users with Provisioning, Maintenance, or Retrieve security levels. (The IP 
address suppression is not applied to users with Superuser security level.)

Note IP address suppression is not applied to users with Superuser security level. However, in 
secure mode the backplane IP address visibility can be restricted to only a locally connected 
Superuser viewing the routing table. In this case, the backplane IP address is not revealed to 
any user at any other NE, either on the routing table or in autonomous messages (such as the 
TL1 REPT DBCHG message, alarms, and performance monitoring [PM] reporting).

• Forward DHCP Request To—Check this check box to enable DHCP. Also, enter the DHCP server 
IP address in the Request To field. Unchecked is the default. If you will enable any of the gateway 
settings to implement the ONS 15454 SOCKS proxy server features, do not check this check box.

Note If you enable DHCP, computers connected to an ONS 15454 node can obtain temporary IP 
addresses from an external DHCP server. The ONS 15454 only forwards DHCP requests; it 
does not act as a DHCP server.

• Gateway Settings—Provisions the ONS 15454 SOCKS proxy server features. (SOCKS is a standard 
proxy protocol for IP-based applications.) Do not change these options until you review Scenario 7 
“Provisioning the ONS 15454 Proxy Server” in the “Management Network Connectivity” chapter 
of the Cisco ONS 15454 DWDM Reference Manual. In SOCKS proxy server networks, the 
ONS 15454 is either an ENE, a GNE, or a proxy-only server. Provisioning must be consistent for 
each NE type.
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• Enable SOCKS proxy server on port—If checked, the ONS 15454 serves as a proxy for connections 
between CTC clients and ONS 15454 nodes that are connected by data communications channels 
(DCCs) to the proxy ONS 15454. The CTC client establishes connections to DCC-connected nodes 
through the proxy node. The CTC client does not require IP connectivity to the DCC-connected 
nodes; it only requires IP connectivity to the proxy ONS 15454. If the Enable SOCKS proxy server 
on port check box is unchecked, the node does not proxy for any CTC clients. When this box is 
checked, you can provision one of the following options:

– External Network Element (ENE)—Choose this option when the ONS 15454 is not connected 
to a LAN but has DCC connections to other ONS nodes. A CTC computer connected to the ENE 
through the TCC2/TCC2P card TCP/IP (craft) port can manage nodes that have DCC 
connections to the ENE. However, the CTC computer does not have direct IP connectivity to 
these nodes or to any LAN or WAN that those nodes might be connected to.

– Gateway Network Element (GNE)—Choose this option when the ONS 15454 is connected to 
a LAN and has DCC connections to other nodes. A CTC computer connected to the LAN can 
manage all nodes that have DCC connections to the GNE, but the CTC computer does not have 
direct IP connectivity to them. The GNE option isolates the LAN from the DCC network so that 
IP traffic originating from the DCC-connected nodes and any CTC computers connected to 
them is prevented from reaching the LAN.

– SOCKS proxy only—Choose this option when the ONS 15454 is connected to a LAN and the 
LAN is separated from the node by a firewall. The SOCKS proxy only option is the same as the 
GNE option, except that the SOCKS proxy only option does not isolate the DCC network from 
the LAN.

Note If a node is provisioned in secure mode, it is automatically provisioned as a GNE with SOCKS 
proxy enabled. However, this provisioning can be overridden, and the secure node can be 
changed to an ENE. In secure mode, SOCKS cannot be disabled. For information about 
provisioning, including GNE and ENE status, see the “DLP-G264 Enable Secure Mode” task on 
page 3-20.

Step 3 Click Apply.

Step 4 Click Yes in the confirmation dialog box.

Both TCC2/TCC2P cards reboot one at a time if changes were made to the IP address, subnet mask, or 
gateway settings. During this time (approximately 5 to 6 minutes), the active and standby TCC2/TCC2P 
card LEDs will blink, turn on, and turn off at different intervals. Eventually, a “Lost node connection, 
switching to network view” message appears.

Step 5 Click OK. The network view appears. The node icon appears in gray, during which time you cannot 
access the node.

Step 6 Double-click the node icon when it becomes green. 

Step 7 Return to your originating procedure (NTP). 
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DLP-G439 Provision the Designated SOCKS Servers

Note To complete this task, you must have either the IP addresses or DNS names of all ONS 15454s in the 
network with LAN access that have SOCKS proxy enabled.

Note SOCKS proxy servers can be any accessible ONS network nodes that have LAN access, including the 
ONS 15310-MA, ONS 15310-CL, ONS 15454, ONS 15454 SDH, ONS 15600, and ONS 15600 SDH 
nodes.

Note You must repeat this task any time that changes to SOCKS proxy server nodes occur, for example, 
whenever LAN connectivity is added to or removed from a node, or when nodes are added or removed 
from the network.

Note If you cannot log into a network node, complete the “DLP-G46 Log into CTC” task on page 2-26 
choosing the Disable Network Discovery option. Complete this task, then login again with network 
discovery enabled.

Step 1 From the CTC Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the SOCKS tab.

Step 3 In the Designated SOCKS Server field, type the IP address or DNS node name of the first ONS 15454 
SOCKS server. The ONS 15454 that you enter must have SOCKS proxy server enabled, and it must have 
LAN access. 

Step 4 Click Add. The node is added to the SOCKS server list. If you need to remove a node on the list, click 
Remove.

Step 5 Repeat Steps 3 and 4 to add all qualified ONS 15454s within the network. Add all ONS nodes that have 
SOCKS proxy enabled and are connected to the LAN. 

Purpose This task identifies the ONS 15454 SOCKS servers in 
SOCKS-proxy-enabled networks. Identifying the SOCKS servers reduces 
the amount of time required to log into a node and have all NEs appear in 
network view (NE discovery time). The task is recommended when the 
combined CTC login and NE discovery time is greater than five minutes in 
networks with SOCKS proxy enabled. Long (or failed) login and NE 
discovery times can occur in networks that have a high ENE-to-GNE ratio 
and a low number of ENEs with LAN connectivity.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 6 Click Check All Servers. CTC verifies that all nodes can perform as SOCKS servers. Once verified, a 
check is placed next to the node IP address or node name in the SOCKS server list. An X placed next to 
the node indicates one or more of the following:

• The entry does not correspond to a valid DNS name.

• The numeric IP address is invalid.

• The node cannot be reached.

• The node can be reached, but the SOCKS port cannot be accessed, for example, a firewall problem 
might exist.

Step 7 Click Apply. The list of ONS 15454 nodes, including ones that received an X in Step 6, are added as 
SOCKS servers.

Step 8 Click OK to close the Preferences dialog box.

Step 9 Return to your originating procedure (NTP). 

DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD

Note You cannot perform this task if the LCD IP Display field on the node view Provisioning > Network tab 
is set to Display Only or Suppress Display. See the “DLP-G56 Provision IP Settings” task on page 3-14 
to view or change the LCD IP Display field. If the node is locked in secure mode with the LCD display 
disabled, you will not be able to change this provisioning unless the lock is disabled by Cisco Technical 
Support. Refer to the “Management Network Connectivity” chapter in the Cisco ONS 15454 DWDM 
Reference Manual for more information about secure mode. 

Note The LCD reverts to normal display mode after 5 seconds of button inactivity.

Step 1 On the ONS 15454 front panel, repeatedly press the Slot button until SHELF appears on the first line of 
the LCD. You are in the Shelf menu.

Step 2 Repeatedly press the Port button until the following information appears:

• To change the node IP address, Node Status=IpAddress (Figure 3-2)

• To change the node network mask, Node Status=Net Mask

• To change the default router IP address, Node Status=Default Rtr

Purpose This task changes the ONS 15454 IP address, default router, and network 
mask using the LCD on the fan-tray assembly. Use this task if you cannot 
log into CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 or TCC2P Card, page 1-77

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 3-2 Selecting the IP Address Option

Step 3 Press the Status button to display the node IP address (Figure 3-3), the node subnet mask length, or the 
default router IP address.

Figure 3-3 Changing the IP Address

Step 4 Push the Slot button to move to the digit of the IP address, subnet mask, or default router that you want 
to change. The selected digit flashes.

Tip The Slot, Status, and Port button positions correspond to the positions of the commands shown 
on the LCD. For example, in Figure 3-3, you press the Slot button to invoke the Next command 
and the Status button to invoke the Done command.

Step 5 Press the Port button to cycle the IP address, subnet mask, or default router to the correct digit.

Step 6 When the change is complete, press the Status button to return to the relevant Node Status menu.

Step 7 Repeatedly press the Port button until the Shelf Save Configuration option appears (Figure 3-4).

Figure 3-4 Selecting the Save Configuration Option

Step 8 Press the Status button to choose the Save Configuration option.

A Save and REBOOT message appears (Figure 3-5).

Figure 3-5 Saving and Rebooting the TCC2/TCC2P
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Step 9 Press the Slot button to apply the new IP address, subnet mask, or default router configuration or press 
Port to cancel the configuration.

Note The IP address and default router must be on the same subnet. If not, you cannot apply the 
configuration. 

Step 10 Saving the new configuration causes the TCC2/TCC2P cards to reboot. During the reboot, a “TCC may 
Reset” message appears on the LCD. The LCD returns to the normal alternating display after both 
TCC2/TCC2P cards finish rebooting.

Step 11 Return to your originating procedure (NTP).

DLP-G264 Enable Secure Mode

Caution The IP address assigned to the TCC2P TCP/IP (LAN) port must reside on a different subnet from the 
backplane LAN port and the ONS 15454 default router. Verify that the new TCC2P IP address meets this 
requirement and is compatible with ONS 15454 network IP addresses.

Note The node will reboot after you complete this task, causing a temporary disconnection between the CTC 
computer and the node.

Note If an OTS-to-OTS PPC is created between nodes, it will no longer function if the node Security Mode is 
enabled (see DLP-G264 Enable Secure Mode, page 3-20). The reason for this is that if the Secure mode 
is enabled, it is no longer possible for the DCN extension feature to use the LAN interface to extend the 
internal network (due to the network isolation in this configuration mode). The result is that the topology 
discovery on the OTS-to-OTS PPC no longer operates.

Step 1 Click the Provisioning > Security > Data Comm tabs. 

Purpose This task enables the ONS 15454 security mode. When security mode is 
enabled, two IP addresses are assigned to the node. One address is assigned 
to the backplane LAN port and the other to the TCC2P RJ-45 TCP/IP 
(LAN) port. The TCC2 card does not support security mode.

Tools/Equipment TCC2P cards must be installed. Do not install a mix of TCC2 and TCC2P 
cards.

Prerequisite Procedures NTP-G103 Back Up the Database, page 13-2

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note The security mode options are not available in CTC if TCC2 cards or a mix of TCC2 and TCC2P 
cards are installed.

Step 2 Click Change Mode.

Step 3 Review the information on the Change Secure Mode page, then click Next.

Step 4 On the TCC Ethernet Port page, enter the IP address and subnet mask for the TCC2P TCP/IP (LAN) port. 
The IP address cannot reside on the same subnet as the backplane LAN port or the ONS 15454 default 
router.

Step 5 Click Next.

Step 6 If needed, on the Backplane Ethernet Port page, modify the backplane IP address, subnet mask, and 
default router. (You normally do not modify these fields if no ONS 15454 network changes have 
occurred.)

Step 7 Click Next. 

Step 8 On the SOCKS Proxy Server Settings page, choose one of the following options:

• External Network Element (ENE)—If selected, the CTC computer is only visible to the 
ONS 15454 where the CTC computer is connected. The CTC computer is not visible to the nodes 
connected to the DCC. In addition, firewall is enabled, which means that the node prevents IP traffic 
from being routed between the DCC and the LAN port. 

• Gateway Network Element (GNE)—If selected, the CTC computer is visible to other 
DCC-connected nodes. The node prevents IP traffic from being routed between the DCC and the 
LAN port. 

Note The SOCKS proxy server is automatically enabled when you enable secure mode.

Step 9 Click Finish.

Within the next 30 to 40 seconds, the TCC2P cards reboot. CTC switches to network view, and the CTC 
Alerts dialog box appears. In network view, the node changes to gray and a DISCONNECTED condition 
appears in the Alarms tab. 

Step 10 In the CTC Alerts dialog box, click Close. Wait for the reboot to finish. (This might take several 
minutes.) 

Step 11 After the DISCONNECTED condition clears, complete the following steps to suppress the backplane IP 
address from appearing in CTC and the LCD. If you do not want to suppress the backplane IP address 
display, continue with Step 12.

a. Display the node in node view (single-shelf mode) or multishelf view (multishelf mode).

b. Click the Provisioning > Security > Data Comm tabs. 

c. In the LCD IP Setting field, choose Suppress Display. The IP address will not appear on the 
ONS 15454 LCD.

d. Check the Suppress CTC IP Address check box. The IP address will not appear in the CTC 
information area or the Provisioning > Security > Data Comm tabs.

e. Click Apply.

Note After you turn on secure mode, the TCC2P IP address becomes the node IP address.
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Step 12 Return to your originating procedure (NTP).

DLP-G58 Create a Static Route

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network tabs.

Step 2 Click the Static Routing tab. Click Create.

Step 3 In the Create Static Route dialog box, enter the following: 

• Destination—Enter the IP address of the computer running CTC. To limit access to one computer, 
enter the full IP address and a subnet mask of 255.255.255.255. To allow access to all computers on 
the 192.168.1.0 subnet, enter 192.168.1.0 and a subnet mask of 255.255.255.0. You can enter a 
destination of 0.0.0.0 to allow access to all CTC computers that connect to the router.

• Mask—Enter a subnet mask. If the destination is a host route (that is, one CTC computer), enter a 
32-bit subnet mask (255.255.255.255). If the destination is a subnet, adjust the subnet mask 
accordingly, for example, 255.255.255.0. If the destination is 0.0.0.0, CTC automatically enters a 
subnet mask of 0.0.0.0 to provide access to all CTC computers. You cannot change this value.

• Next Hop—Enter the IP address of the router port or the node IP address if the CTC computer is 
connected to the node directly.

• Cost—Enter the number of hops between the ONS 15454 and the computer. 

Step 4 Click OK. Verify that the static route appears in the Static Route window.

Note Static route networking examples are provided in the “Management Network Connectivity” 
chapter of the Cisco ONS 15454 DWDM Reference Manual.

Purpose This task creates a static route to establish CTC connectivity to a computer 
on another network. This task is performed when one of the following 
conditions exists:

• CTC computers on one subnet need to connect to ONS 15454 nodes 
that are connected by a router to ONS 15454 nodes residing on another 
subnet. 

• OSPF is not enabled (the OSPF Active on LAN check box is not 
checked on the Provisioning > Network > OSPF tab) and the External 
Network Element (ENE) gateway setting is not checked.

• You need to enable multiple CTC sessions among ONS 15454 nodes 
residing on the same subnet and the External Network Element (ENE) 
gateway setting is not checked.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Return to your originating procedure (NTP).

DLP-G59 Set Up or Change Open Shortest Path First Protocol

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > OSPF tabs.

Step 2 On the top left side of the OSPF area, complete the following:

• DCC/GCC OSPF Area ID Table—In dotted decimal format, enter the number that identifies the 
ONS 15454 nodes as a unique OSPF area ID. The Area ID can be any number between 
000.000.000.000 and 255.255.255.255, but must be unique to the LAN OSPF area.

ANSI Nodes

• SDCC Metric—This value is normally unchanged. It sets a cost for sending packets across the 
Section DCC, which is used by OSPF routers to calculate the shortest path. This value should always 
be higher than the LAN metric. The default SDCC metric is 100. 

• LDCC Metric—Sets a cost for sending packets across the Line DCC. This value should always be 
lower than the SDCC metric. The default LDCC metric is 33. It is usually not changed.

ETSI Nodes

• RS-DCC Metric—This value is normally unchanged. It sets a cost for sending packets across the 
regenerator section DCC (RS-DCC), which is used by OSPF routers to calculate the shortest path. 
This value should always be higher than the LAN metric. The default RS-DCC metric is 100. 

• MS-DCC Metric—Sets a cost for sending packets across the multiplex section DCC (MS-DCC). 
This value should always be lower than the SDCC metric. The default MS-DCC metric is 33. It is 
usually not changed.

Step 3 In the OSPF on LAN area, complete the following:

• OSPF active on LAN—When checked, enables the ONS 15454 OSPF topology to be advertised to 
OSPF routers on the LAN. Enable this field on ONS 15454 nodes that directly connect to OSPF 
routers.

• LAN Port Area ID—Enter the OSPF area ID (dotted decimal format) for the router port where the 
ONS 15454 is connected. (This number is different from the DCC/GCC OSPF Area ID.)

Purpose This task enables the OSPF routing protocol on the ONS 15454. Perform 
this task if you want to include the ONS 15454 in OSPF-enabled networks.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

You will need the OSPF Area ID, Hello and Dead intervals, and 
authentication key (if OSPF authentication is enabled) provisioned on the 
router to which the ONS 15454 is connected.

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 By default, OSPF is set to No Authentication. If the OSPF router requires authentication, complete the 
following steps. If not, continue with Step 5.

a. Click the No Authentication button.

b. In the Edit Authentication Key dialog box, complete the following:

• Type—Choose Simple Password.

• Enter Authentication Key—Enter the password.

• Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 5 Provision the OSPF priority and interval settings. The OSPF priority and interval defaults are the 
defaults most commonly used by OSPF routers. Verify that these defaults match the ones used by the 
OSPF router where the ONS 15454 is connected.

• Router Priority—Provision the router priority, which determines the designated router for a subnet.

• Hello Interval (sec)—Provision the number of seconds between OSPF hello packet advertisements 
sent by OSPF routers. Ten seconds is the default.

• Dead Interval—Provision the number of seconds that will pass while an OSPF router’s packets are 
not visible before its neighbors declare the router down. Forty seconds is the default.

• Transit Delay (sec)—Provision the service speed. One second is the default.

• Retransmit Interval (sec)—Provision the number of seconds that will elapse before a packet is 
resent. Five seconds is the default.

• LAN Metric—Provision the cost for sending packets across the LAN. This value should always be 
lower than the SDCC or RS-DCC metric. Ten is the default.

Step 6 Under OSPF Area Range Table, create an area range table if one is needed:

Note Area range tables consolidate the information that is outside an OSPF area border. One 
ONS 15454 in the ONS 15454 OSPF area is connected to the OSPF router. An area range table 
on this node points the router to the other nodes that reside within the ONS 15454 OSPF area. 

a. Click Create.

b. In the Create Area Range dialog box, enter the following:

• Range Address—Enter the area IP address for the ONS 15454 nodes that reside within the 
OSPF area. For example, if the ONS 15454 OSPF area includes nodes with IP addresses 
10.10.20.100, 10.10.30.150, 10.10.40.200, and 10.10.50.250, the range address would be 
10.10.0.0.

• Range Area ID—Enter the OSPF area ID for the ONS 15454 nodes. This is either the ID in the 
DCC OSPF Area ID field or the ID in the Area ID for LAN Port field.

• Mask Length—Enter the subnet mask length. In the Range Address example, this is 16. 

• Advertise—Check this box if you want to advertise the OSPF range table.

c. Click OK.
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Step 7 All OSPF areas must be connected to Area 0. If the ONS 15454 OSPF area is not physically connected 
to Area 0, use the following steps to create a virtual link table that will provide the disconnected area 
with a logical path to Area 0:

a. Under the OSPF Virtual Link Table, click Create.

b. In the Create Virtual Link dialog box, complete the following fields. OSPF settings must match 
OSPF settings for the ONS 15454 OSPF area:

• Neighbor—Enter the router ID of the Area 0 router.

• Transit Delay (sec)—Enter the service speed. One second is the default.

• Hello Int (sec)—Provision the number of seconds between OSPF hello packet advertisements 
sent by OSPF routers. Ten seconds is the default.

• Auth Type—If the router where the ONS 15454 is connected uses authentication, choose 
Simple Password. Otherwise, choose No Authentication.

• Retransmit Int (sec)—Provision the time that will elapse, in seconds, before a packet is resent. 
Five seconds is the default.

• Dead Int (sec)—Provision the number of seconds that will pass while an OSPF router’s packets 
are not visible before its neighbors declare the router down. Forty seconds is the default.

c. Click OK.

Step 8 After entering the ONS 15454 OSPF area data, click Apply.

If you changed the Area ID, the TCC2/TCC2P cards reset, one at a time. The reset takes approximately 
10 to 15 minutes.

Step 9 Return to your originating procedure (NTP).

DLP-G60 Set Up or Change Routing Information Protocol

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Network > RIP tabs. 

Step 2 Check the RIP Active check box if you are activating RIP. 

Step 3 Choose either RIP Version 1 or RIP Version 2 from the drop-down list, depending on which version is 
supported in your network. 

Purpose This task enables RIP on the ONS 15454. Perform this task if you want to 
include the ONS 15454 in RIP-enabled networks.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

You need to create a static route to the router adjacent to the ONS 15454 
for the ONS 15454 to communicate its routing information to 
non-DCC-connected nodes.

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Set the RIP metric. The RIP metric can be set to a number between 1 and 15 and represents the number 
of hops. 

Step 5 By default, RIP is set to No Authentication. If the router that the ONS 15454 is connected to requires 
authentication, complete the following steps. If not, continue with Step 6.

a. Click the No Authentication button.

b. In the Edit Authentication Key dialog box, complete the following:

• Type—Choose Simple Password.

• Enter Authentication Key—Enter the password.

• Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 6 If you want to complete an address summary, complete the following steps. If not, continue with Step 7. 
Complete the address summary only if the ONS 15454 is a gateway NE with multiple external 
ONS 15454 NEs attached with IP addresses in different subnets.

a. In the RIP Address Summary area, click Create.

b. In the Create Address Summary dialog box, complete the following:

• Summary Address—Enter the summary IP address.

• Mask Length—Enter the subnet mask length using the up and down arrows.

• Hops—Enter the number of hops. The smaller the number of hops, the higher the priority.

c. Click OK.

Step 7 Return to your originating procedure (NTP).

NTP-G194 Set Up EMS Access to the ONS 15454

Step 1 In node view, click the Provisioning > Security > Access pane.

Step 2 Under the EMS Access area, change the Access State to Secure.

Step 3 Click Apply. The CTC disconnects and reconnects through a secure socket connection.

Step 4 To create a secure connection, enter https://node-address.

Purpose This procedure provisions ONS 15454s and CTC computers for secure 
access.

Tools/Equipment None

Prerequisite Procedures NTP-G26 Set Up CTC Network Access, page 3-13

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Note After setting up a CTC connection in secure mode, http requests are automatically redirected to https 
mode.

Step 5 A first time connection is authenticated by the Website Certification is Not Known dialog box. Accept 
the certificate and click OK. The Security Error: Domain Name Mismatch dialog box appears. Click 
OK to continue.

Stop. You have completed this procedure.

NTP-G341 Set Up Secure Access to the ONS 15454 TL1

Step 1 In the node view, click the Provisioning > Security > Access pane.

Step 2 Under the TL1 Access area, change the Access State to Secure.

Step 3 Click Apply. 

Existing non-secure TL1 sessions, if any, are terminated.

Step 4 To create a secure TL1 connection, enter the following command at the UNIX or Linux prompt:

ssh -l username node-ip -p port-number

The port number for secure TL1 is 4083.

Note Use any SSH client on Windows.

Stop. You have completed this procedure.

NTP-G27 Set Up the ONS 15454 for Firewall Access

Purpose This procedure provisions ONS 15454s for secure access to TL1.

Tools/Equipment None

Prerequisite Procedures NTP-G26 Set Up CTC Network Access, page 3-13

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This procedure provisions ONS 15454 nodes and CTC computers for 
access through firewalls.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5
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Step 1 Log into a node that is behind the firewall. See the “DLP-G46 Log into CTC” task on page 2-26 for 
instructions. If you are already logged in, continue with Step 2.

Step 2 If the ONS 15454 node is in a protected network and the CTC computer is in an external network, 
complete the “DLP-G61 Provision the IIOP Listener Port on the ONS 15454” task on page 3-29.

Figure 3-6 shows ONS 15454 nodes in a protected network and the CTC computer in an external 
network. For the computer to access the ONS 15454 nodes, you must provision the IIOP listener port 
specified by your firewall administrator on the ONS 15454. 

Figure 3-6 Nodes Behind a Firewall

Step 3 If the CTC computer resides behind a firewall, complete the “DLP-G62 Provision the IIOP Listener Port 
on the CTC Computer” task on page 3-30.

Figure 3-7 shows a CTC computer and ONS 15454 behind firewalls. For the computer to access the 
ONS 15454, you must provision the IIOP port on the CTC computer and on the ONS 15454. 

Figure 3-7 CTC Computer and ONS 15454 Nodes Residing Behind Firewalls

Stop. You have completed this procedure.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G61 Provision the IIOP Listener Port on the ONS 15454

Note If the Enable SOCKS proxy on port 1080 check box is checked, CTC will use Port 1080 and ignore the 
configured IIOP port setting. If the check box is later unchecked, the configured IIOP listener port will 
be used.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Security > Access tabs.

Step 2 In the TCC CORBA (IIOP) Listener Port area, choose a listener port option:

• Default - TCC Fixed—Uses Port 57790 to connect to ONS 15454 nodes on the same side of the 
firewall or if no firewall is used (default). This option can be used for access through a firewall if 
Port 57790 is available.

• Standard Constant—Uses Port 683, the Common Object Request Broker Architecture (CORBA) 
default port number.

• Other Constant—If Port 683 is not used, type the IIOP port specified by your firewall 
administrator. 

Step 3 Click Apply.

Step 4 When the Change Network Configuration message appears, click Yes. 

Both ONS 15454 TCC2/TCC2P cards reboot, one at a time. The reboot takes approximately 15 minutes. 

Step 5 Return to your originating procedure (NTP).

Purpose This task sets the IIOP listener port on the ONS 15454, which enables you 
to access ONS 15454 nodes that reside behind a firewall.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G62 Provision the IIOP Listener Port on the CTC Computer

Step 1 From the Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the Firewall tab.

Step 3 In the CTC CORBA (IIOP) Listener Port area, choose a listener port option:

• Default - Variable—Use to connect to ONS 15454 nodes from within a firewall or if no firewall is 
used (default).

• Standard Constant—Use Port 683, the CORBA default port number.

• Other Constant—If Port 683 is not used, enter the IIOP port defined by your administrator.

Step 4 Click Apply. A warning appears telling you that the port change will apply during the next CTC login.

Step 5 Click OK. 

Step 6 In the Preferences dialog box, click OK.

Step 7 To access the ONS 15454 using the IIOP port, log out of CTC then log back in. (To log out, choose Exit 
from the File menu).

Step 8 Return to your originating procedure (NTP).

Purpose This task selects the IIOP listener port for CTC and must be completed if 
the computer running CTC resides behind a firewall.

Tools/Equipment IIOP listener port number from LAN or firewall administrator

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

DLP-G46 Log into CTC, page 2-26 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Caution This procedure requires an understanding of OSI protocols, parameters, and functions. Before you begin, 
review the OSI reference sections in the “Management Network Connectivity” chapter of the 
Cisco ONS 15454 DWDM Reference Manual and ensure that you know the role of the ONS 15454 within 
the OSI and IP network.

Note This procedure requires provisioning of non-ONS equipment including routers and third party NEs. Do 
not begin until you have the capability to complete that provisioning.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to provision the 
OSI. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the following tasks: 

• DLP-G283 Provision OSI Routing Mode, page 3-32—Complete this task first.

• DLP-G284 Provision the TARP Operating Parameters, page 3-33—Complete this task second.

• DLP-G285 Add a Static TID-to-NSAP Entry to the TARP Data Cache, page 3-35—Complete this 
task as needed.

• DLP-G287 Add a TARP Manual Adjacency Table Entry, page 3-36—Complete this task as needed.

• DLP-G288 Provision OSI Routers, page 3-37—Complete this task as needed.

• DLP-G289 Provision Additional Manual Area Addresses, page 3-38—Complete this task as needed.

• DLP-G290 Enable the OSI Subnet on the LAN Interface, page 3-38—Complete this task as needed.

• DLP-G291 Create an IP-Over-CLNS Tunnel, page 3-40—Complete this task as needed.

Stop. You have completed this procedure.

Purpose This procedure provisions the ONS 15454 so it can be installed in networks 
with other vendor NEs that use the OSI protocol stack for data 
communications network (DCN) communications. This procedure 
provisions the Target Identifier Address Resolution Protocol (TARP), OSI 
routers, manual area addresses, subnetwork points of attachment, and 
IP-over-Connectionless Network Service (CLNS) tunnels.

Tools/Equipment None

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-76

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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DLP-G283 Provision OSI Routing Mode

Caution Do not complete this task until you confirm the role of the node within the network. It will be either an 
End System, Intermediate System Level 1, or IS Level 1/Level 2. This decision must be carefully 
considered. For additional information about OSI provisioning, refer to the “Management Network 
Connectivity” chapter of the Cisco ONS 15454 DWDM Reference Manual.

Caution Link State Protocol (LSP) buffers must be the same at all NEs within the network, or loss of visibility 
might occur. Do not modify the LSP buffers unless you confirm that all NEs within the OSI have the 
same buffer size.

Caution LSP buffer sizes cannot be greater than the LAP-D maximum transmission unit (MTU) size within the 
OSI area.

Note For ONS 15454 nodes, three virtual routers can be provisioned. The node primary Network Service 
Access Point (NSAP) address is also the Router 1 primary manual area address. To edit the primary 
NSAP, you must edit the Router 1 primary manual area address. After you enable Router 1 on the Routers 
subtab, the Change Primary Area Address button is available to edit the address.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > OSI 
tabs.

Step 2 Choose a routing mode:

• End System—The ONS 15454 performs OSI end system (ES) functions and relies upon an 
intermediate system (IS) for communication with nodes that reside within its OSI area.

Note The End System routing mode is not available if more than one virtual router is enabled. 

• Intermediate System Level 1—The ONS 15454 performs OSI IS functions. It communicates with 
IS and ES nodes that reside within its OSI area. It depends upon an IS L1/L2 node to communicate 
with IS and ES nodes that reside outside its OSI area.

Purpose This task provisions the OSI routing mode. Complete this task when the 
ONS 15454 is connected to networks with third party NEs that use the OSI 
protocol stack for DCN communication.

Tools/Equipment None

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-76

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• Intermediate System Level 1/Level 2—The ONS 15454 performs IS functions. It communicates 
with IS and ES nodes that reside within its OSI area. It also communicates with IS L1/L2 nodes that 
reside in other OSI areas. Before choosing this option, verify the following:

– The node is connected to another IS Level 1/Level 2 node that resides in a different OSI area.

– The node is connected to all nodes within its area that are provisioned as IS L1/L2.

Step 3 If needed, change the LSP data buffers:

• L1 LSP Buffer Size—Adjusts the Level 1 link state protocol data unit (PDU) buffer size. The default 
is 512. It should not be changed.

• L2 LSP Buffer Size—Adjusts the Level 2 link state PDU buffer size. The default is 512. It should 
not be changed.

Step 4 Return to your originating procedure (NTP).

DLP-G284 Provision the TARP Operating Parameters

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > OSI > 
TARP > Config tabs.

Step 2 Provision the following parameters, as needed:

• TARP PDUs L1 Propagation—If checked (default), TARP Type 1 PDUs that are received by the 
node and are not excluded by the LDB are propagated to other NEs within the Level 1 OSI area. 
(Type 1 PDUs request a protocol address that matches a target identifier [TID] within a Level 1 
routing area.) The propagation does not occur if the NE is the target of the Type 1 PDU, and PDUs 
are not propagated to the NE from which the PDU was received.

Note The TARP PDUs L1 Propagation parameter is not used when the Node Routing Area (on the 
Provisioning > OSI > Main Setup tab) is set to End System.

• TARP PDUs L2 Propagation—If checked (default), TARP Type 2 PDUs that are received by the 
node and are not excluded by the LDB are propagated to other NEs within the Level 2 OSI areas. 
(Type 2 PDUs request a protocol address that matches a TID within a Level 2 routing area.) The 
propagation occurs if the NE is not the target of the Type 2 PDU, and PDUs are not propagated to 
the NE from which the PDU was received.

Note The TARP PDUs L2 Propagation parameter is only used when the Node Routing Area is 
provisioned to Intermediate System Level 1/Level 2.

Purpose This task provisions the TARP operating parameters including TARP PDU 
propagation, timers, and loop detection buffer (LDB).

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-26

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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• TARP PDUs Origination—If checked (default), the node performs all TARP origination functions 
including:

– TID-to-NSAP resolution requests (originate TARP Type 1 and Type 2 PDUs)

– NSAP-to-TID requests (originate Type 5 PDUs)

– TARP address changes (originate Type 4 PDUs)

Note TARP Echo and NSAP to TID are not supported.

• TARP Data Cache—If checked (default), the node maintains a TARP data cache (TDC). The TDC 
is a database of TID-to-NSAP pairs created from TARP Type 3 PDUs received by the node and 
modified by TARP Type 4 PDUs (TID-to-NSAP updates or corrections). TARP 3 PDUs are 
responses to Type 1 and Type 2 PDUs. The TDC can also be populated with static entries entered 
on the TARP > Static TDC tab.

Note TARP Data Cache is only used when the TARP PDUs Origination parameter is enabled.

• L2 TARP Data Cache—If checked (default), the TIDs and NSAPs of NEs originating Type 2 
requests are added to the TDC before the node propagates the requests to other NEs. 

Note The L2 TARP Data Cache parameter is designed for Intermediate System Level 1/Level 2 
nodes that are connected to other Intermediate System Level 1/Level 2 nodes. Enabling the 
parameter for Intermediate System Level 1 nodes is not recommended.

• LDB—If checked (default), enables the TARP loop detection buffer. The LDB prevents TARP PDUs 
from being sent more than once on the same subnet.

Note The LDB parameter is not used if the Node Routing Mode is provisioned to End System or 
if the TARP PDUs L1 Propagation parameter is not enabled. 

• LAN TARP Storm Suppression—If checked (default), enables TARP storm suppression. This 
function prevents redundant TARP PDUs from being unnecessarily propagated across the LAN 
network.

• Send Type 4 PDU on Startup—If checked, a TARP Type 4 PDU is originated during the initial 
ONS 15454 startup. Type 4 PDUs indicate that a TID or NSAP change has occurred at the NE. (The 
default setting is not enabled.)

• Type 4 PDU Delay—Sets the amount of time that will pass before the Type 4 PDU is generated when 
Send Type 4 PDU on Startup is enabled. 60 seconds is the default. The range is 0 to 255 seconds.

Note The Send Type 4 PDU on Startup and Type 4 PDU Delay parameters are not used if TARP 
PDUs Origination is not enabled.

• LDB Entry—Sets the TARP loop detection buffer timer. The loop detection buffer time is assigned 
to each LDB entry for which the TARP sequence number (tar-seq) is zero. The default is 5 minutes. 
The range is 1 to 10 minutes.
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• LDB Flush—Sets the frequency period for flushing the LDB. The default is 5 minutes. The range is 
0 to 1440 minutes. 

• T1—Sets the amount of time to wait for a response to a Type 1 PDU. Type 1 PDUs seek a specific 
NE TID within an OSI Level 1 area. The default is 15 seconds. The range is 0 to 3600 seconds.

• T2—Sets the amount of time to wait for a response to a Type 2 PDU. TARP Type 2 PDUs seek a 
specific NE TID value within OSI Level 1 and Level 2 areas. The default is 25 seconds. The range 
is 0 to 3600 seconds.

• T3—Sets the amount of time to wait for an address resolution request. The default is 40 seconds. 
The range is 0 to 3600 seconds.

• T4—Sets the amount of time to wait for an error recovery. This timer begins after the T2 timer 
expires without finding the requested NE TID. The default is 20 seconds. The range is 
0 to 3600 seconds.

Note The T1, T2, and T4 timers are not used if the TARP PDUs Origination check box is not 
checked. 

Step 3 Click Apply.

Step 4 Return to your originating procedure (NTP).

DLP-G285 Add a Static TID-to-NSAP Entry to the TARP Data Cache

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > OSI > 
TARP > Static TDC tabs.

Step 2 Click Add Static Entry.

Step 3 In the Add Static Entry dialog box, enter the following:

• TID—Enter the TID of the NE. (For ONS nodes, the TID is the Node Name parameter on the node 
or multishelf view Provisioning > General tab.)

• NSAP—Enter the OSI NSAP address in the NSAP field or, if preferred, click Use Mask and enter 
the address in the Masked NSAP Entry dialog box.

Purpose This task adds a static TID-to-NSAP entry to the TDC. The static entries 
are required for NEs that do not support TARP and are similar to static 
routes. For a specific TID, you must force a specific NSAP. 

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-26

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioner or higher
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Step 4 Click OK to close the Masked NSAP Entry dialog box, if used, and then click OK to close the 
Add Static Entry dialog box.

Step 5 Return to your originating procedure (NTP).

DLP-G287 Add a TARP Manual Adjacency Table Entry

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > OSI > 
TARP > MAT tabs.

Step 2 Click Add.

Step 3 In the Add TARP Manual Adjacency Table Entry dialog box, enter the following:

• Level—Sets the TARP Type Code that will be sent:

– Level 1—Indicates that the adjacency is within the same area as the current node. The entry 
generates Type 1 PDUs.

– Level 2—Indicates that the adjacency is in a different area than the current node. The entry 
generates Type 2 PDUs.

• NSAP—Enter the OSI NSAP address in the NSAP field or, if preferred, click Use Mask and enter 
the address in the Masked NSAP Entry dialog box.

Step 4 Click OK to close the Masked NSAP Entry dialog box, if used, and then click OK to close the Add Static 
Entry dialog box.

Step 5 Return to your originating procedure (NTP).

Purpose This task adds an entry to the TARP manual adjacency table (MAT). Entries 
are added to the MAT when the ONS 15454 must communicate across 
routers or NEs that lack TARP capability. 

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-26

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G288 Provision OSI Routers

Note Router 1 must be enabled before you can enable and edit the primary manual area addresses for 
Routers 2 and 3.

Note The Router 1 manual area address, System ID, and Selector “00” create the node NSAP address. 
Changing the Router 1 manual area address changes the node NSAP address.

Note The System ID for Router 1 is the node MAC address. The System IDs for Routers 2 and 3 are created 
by adding 1 and 2 respectively to the Router 1 System ID. You cannot edit the System IDs.

Step 1 Click the Provisioning > OSI > Routers > Setup tabs. 

Step 2 Chose the router you want provision and click Edit. The OSI Router Editor dialog box appears.

Step 3 In the OSI Router Editor dialog box:

a. Check Enable Router to enable the router and make its primary area address available for editing.

b. Click the manual area address, then click Edit.

c. In the Edit Manual Area Address dialog box, edit the primary area address in the Area Address field. 
If you prefer, click Use Mask and enter the edits in the Masked NSAP Entry dialog box. The address 
(hexadecimal format) can be 8 to 24 alphanumeric characters (0–9, a–f) in length.

d. Click OK successively to close the following dialog boxes: Masked NSAP Entry (if used), Edit 
Manual Area Address, and OSI Router Editor.

Step 4 Return to your originating procedure (NTP).

Purpose This task enables an OSI router and edits its primary manual area address.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G289 Provision Additional Manual Area Addresses

Step 1 Click the Provisioning > OSI > Routers > Setup tabs. 

Step 2 Chose the router where you want provision an additional manual area address and click Edit. The OSI 
Router Editor dialog box appears.

Step 3 In the OSI Router Editor dialog box:

a. Check Enable Router to enable the router and make its primary area address available for editing.

b. Click the manual area address, then click Add.

c. In the Add Manual Area Address dialog box, enter the primary area address in the Area Address 
field. If you prefer, click Use Mask and enter the address in the Masked NSAP Entry dialog box. 
The address (hexadecimal format) can be 2 to 24 alphanumeric characters (0–9, a–f) in length.

d. Click OK successively to close the following dialog boxes: Masked NSAP Entry (if used), Add 
Manual Area Address, and OSI Router Editor.

Step 4 Return to your originating procedure (NTP).

DLP-G290 Enable the OSI Subnet on the LAN Interface

Note When you create communication channels (optical service channel [OSC] or generic communications 
channel [GCC]), OSI subnetwork points of attachment are enabled on the communication channels. See 
the “NTP-G38 Provision OSC Terminations” procedure on page 3-105 and the “DLP-G76 Provision 
DCC/GCC Terminations” task on page 7-58.

Purpose This task provisions the OSI manual area addresses. One primary area and 
two additional manual areas can be created for each virtual router.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

DLP-G288 Provision OSI Routers, page 3-37

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task enables the OSI subnetwork point of attachment on the LAN 
interface.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The OSI subnetwork point of attachment cannot be enabled for the LAN interface if the OSI routing 
mode is set to ES.

Note If secure mode is on, the OSI subnet is enabled on the backplane LAN port, not the front TCC2P TCP/IP 
(LAN) port.

Step 1 Click the Provisioning > OSI > Routers > Subnet tabs. 

Step 2 Click Enable LAN Subnet.

Step 3 In the Enable LAN Subnet dialog box, complete the following fields:

• ESH—Sets the End System Hello (ESH) propagation frequency. An ES NE transmits ESHs to 
inform other ESs and ISs about the NSAPs it serves. The default is 10 seconds. The range is 10 to 
1000 seconds.

• ISH—Sets the Intermediate System Hello (ISH) PDU propagation frequency. An intermediate 
system NE sends ISHs to other ESs and ISs to inform them about the IS NEs it serves. The default 
is 10 seconds. The range is 10 to 1000 seconds.

• IIH—Sets the Intermediate System to Intermediate System Hello (IIH) PDU propagation frequency. 
The IS-IS Hello PDUs establish and maintain adjacencies between ISs. The default is 3 seconds. The 
range is 1 to 600 seconds.

• IS-IS Cost—Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses the cost 
to calculate the shortest routing path. The default IS-IS cost for LAN subnets is 20. It normally 
should not be changed.

• DIS Priority—Sets the designated intermediate system (DIS) priority. In IS-IS networks, one router 
is elected to serve as the DIS (LAN subnets only). Cisco router DIS priority is 64. For the 
ONS 15454 LAN subnet, the default DIS priority is 63. It normally should not be changed.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).
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DLP-G291 Create an IP-Over-CLNS Tunnel

Caution IP-over-CLNS tunnels require two endpoints. You will create one point on an ONS 15454. The other 
endpoint is generally provisioned on non-ONS equipment including routers and other vendor NEs. 
Before you begin, verify that you have the capability to create an OSI-over-CLNS tunnel on the other 
equipment location.

Step 1 Click the Provisioning > OSI > Tunnels tabs. 

Step 2 Click Create.

Step 3 In the Create IP Over CLNS Tunnel dialog box, complete the following fields:

• Tunnel Type—Choose a tunnel type:

– Cisco—Creates the proprietary Cisco IP tunnel. Cisco IP tunnels add the CLNS header to the 
IP packets.

– GRE—Creates a generic routing encapsulation (GRE) tunnel. GRE tunnels add the CLNS 
header and a GRE header to the IP packets.

The Cisco proprietary tunnel is slightly more efficient than the GRE tunnel because it does not add 
the GRE header to each IP packet. The two tunnel types are not compatible. Most Cisco routers 
support the Cisco IP tunnel, while only a few support both GRE and Cisco IP tunnels. You generally 
should create Cisco IP tunnels if you are tunneling between two Cisco routers or between a Cisco 
router and an ONS node.

Caution Always verify that the IP-over-CLNS tunnel type that you choose is supported by the equipment at the 
other end of the tunnel.

• IP Address—Enter the IP address of the IP-over-CLNS tunnel destination.

• IP Mask—Enter the IP address subnet mask of the IP-over-CLNS destination.

• OSPF Metric—Enter the OSPF metric for sending packets across the IP-over-CLNS tunnel. The 
OSPF metric, or cost, is used by OSPF routers to calculate the shortest path. The default is 110. 
Normally, it is not be changed unless you are creating multiple tunnel routes and want to prioritize 
routing by assigning different metrics.

• NSAP Address—Enter the destination NE or OSI router NSAP address. 

Step 4 Click OK.

Purpose This task creates an IP-over-CLNS tunnel to allow ONS 15454 nodes to 
communicate across equipment and networks that use the OSI protocol 
stack. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Provision the other tunnel endpoint using the documentation provided by the manufacturer of the third 
party vendor NE.

Step 6 Return to your originating procedure (NTP).

NTP-G28 Set Up SNMP

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to set up SNMP. 
If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > SNMP 
tabs.

Step 3 In the Trap Destinations area, click Create.

Step 4 Complete the following in the Create SNMP Trap Destination dialog box (Figure 3-8):

• Destination IP Address—Type the IP address of your network management system (NMS). If the 
node you are logged into is an ENE, set the destination address to the GNE. 

• Community—Type the SNMP community name. For a description of SNMP community names, 
refer to the “SNMP” chapter in the Cisco ONS 15454 DWDM Reference Manual. 

Note The community name is a form of authentication and access control. The community name 
assigned to the ONS 15454 is case-sensitive and must match the community name of the 
NMS.

• UDP Port—The default User Datagram Protocol (UDP) port for SNMP is 162.

• Trap version—Choose either SNMPv1 or SNMPv2. Refer to your NMS documentation to determine 
which version to use.

Purpose This procedure provisions the SNMP parameters so that you can use 
SNMP management software with the ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

Required/As Needed Required if SNMP is used at your site.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 3-8 Creating an SNMP Trap

Step 5 Click OK. The node IP address of the node where you provisioned the new trap destination appears in 
the Trap Destinations area.

Step 6 Click the node IP address in the Trap Destinations area. Verify the SNMP information that appears in 
the Selected Destination list.

Step 7 If you want the SNMP agent to accept SNMP SET requests on certain MIBs, click the Allow SNMP Sets 
check box. If this box is not checked, SET requests are rejected.

Step 8 If you want to set up the SNMP proxy feature to allow network management, message reporting, and 
performance statistic retrieval across ONS firewalls, click the Allow SNMP Proxy check box located on 
the SNMP tab.

Note The Use Generic MIB check box is normally not checked for MSTP. It is checked only when the 
ONS 15454 resides in networks with multiple ONS products, and the network management 
system requires MIBs with the same name to have the same object IDs. By default, the 
ONS 15454 uses the CERENT-454-MIBs. Other ONS products, such as the ONS 15600, the 
ONS 15327, and ONS 15310-CL, use the CERENT-GENERIC-MIBs. If Use Generic MIB is 
checked, the ONS 15454 will use the CERENT-GENERIC-MIBs so the object IDs will be the 
same for all products. 

Note Using the ONS firewall proxy feature effectively breaches the ONS firewall to exchange 
management information.

For more information about the SNMP proxy feature, refer to the “SNMP” chapter in the 
Cisco ONS 15454 DWDM Reference Manual. 

Step 9 Click Apply.

Step 10 If you are setting up SNMP proxies, you can set up to three relays that send SNMP trap error counts back 
to the NE for each trap destination address:

a. Click the first trap destination IP address. The address and its community name appear in the 
Destination fields.

b. Enter up to three SNMP Proxy relay addresses and community names in the fields for Relay A, 
Relay B, and Relay C.

Note The community names specified for each relay node must match one of the provisioned 
SNMP community names in the NE. 
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Note The SNMP proxy directs SNMP traps from this node through Relay A to Relay B to Relay C 
to the trap destination. Ensure that you enter the IP addresses in the correct order so that this 
sequence runs correctly.

Step 11 Click Apply.

Stop. You have completed this procedure.

NTP-G143 Import the Cisco TransportPlanner NE Update 
Configuration File

Caution Verify that you have the correct Cisco TransportPlanner network file before you begin this procedure. 
The file will have an XML extension and a name assigned by your network planner. Check with your 
network planner or administrator if you have any questions.

Note The Cisco TransportPlanner configuration file contains parameters for the node, shelf, card type, port 
(including the card’s wavelength), pluggable port module (PPM), as well as OTN and FEC parameters. 
Only the values present in XML format appear in the configuration file parameters; if the values are not 
in XML format, a column appears blank. The XML file values are independently reported and do not 
affect any manual configuration changes that you applied.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to import the 
Cisco TransportPlanner configuration file. If you are already logged in, continue with Step 2.

Purpose This procedure imports the Cisco TransportPlanner NE Update 
configuration file and creates a log file. The configuration file, which is 
provided in XML format, provisions the shelf layout by preprovisioning 
each slot for the card that will be installed. For TXP, MXP, GE_XP, 
10GE_XP, and ADM-10G cards, the NE Update file provisions the OTN, 
FEC and card mode parameters, and it also provisions the card mode. The 
file provisions internal OCH trunk to OCH filter patchcords, and it 
provisions the optical sides. Finally, the NE Update file installs the ANS 
parameters calculated by Cisco TransportPlanner. The log file, which is a 
text document records the results of the NE update.

Tools/Equipment A Cisco TransportPlanner NE Update file for the network where the node 
is installed must be accessible to the CTC computer.

Prerequisite Procedures NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 2 If you choose the Provision Node Layout option to preprovision the cards in the shelf, complete the 
following steps. If not, continue with Step 3.

a. Display the node in node view (single-shelf mode) or multishelf view (multishelf mode). 

b. Verify that the common control cards (TCC2/TCC2P, AIC-I and MSC-ISC) cards are the only cards 
installed. If in single or multishelf mode, verify that each shelf in the multishelf has two 
TCC2/TCC2P cards.

• If common control cards are the only cards installed, continue with Step 3. 

• If other cards appear, continue with Step c.

c. If a physical card other than the common control cards is installed, remove it from the shelf.

d. If preprovisioned DWDM cards are present, delete them using the “DLP-G351 Delete a Card in 
CTC” task on page 3-47, then repeat Steps a and b.

Step 3 If you have not created a log file to record the results of the NE update, complete the following steps. If 
a log file has been created, continue with Step 4.

a. Open a text editor or word processing application.

b. Create a new text (TXT) document with a file name of your choosing. 

c. Save the text document in a directory that is easy to navigate to from CTC.

Step 4 In CTC node view (single-shelf mode) or multishelf view, click the Provisioning > WDM-ANS > 
Node Setup tabs.

Step 5 In the field under Select XML file, type the path to the Cisco TransportPlanner node setup file containing 
the parameters for the network where your node resides, or click Browse and navigate to the file on your 
computer or network server. Click the file, then click Open. The file will have an XML extension.

Step 6 In the field under Select Log file, type the path to the text file that you created in Step 3, or click Browse 
and navigate to the file on your computer or a network server where you want the node setup results 
recorded. 

Note The log file records parameters that were updated successfully and provides an explanation of 
why an update could not be completed. Each node setup session overwrites the log file contents. 
If you want to save the results from a previous NE update, save the log file with new name.

Step 7 Click Apply.

Step 8 When the Node Setup Selection for Node-Name page appears, complete the following steps. If not, 
continue with Step 9. 

a. Choose the node profile that you want to apply to the node. The Cisco TransportPlanner XML file 
contains profiles for all nodes in the network. Choose the profile that applies to the node you are 
provisioning.

b. Click Next.

Step 9 On the Node Setup for node name page, choose one or more of the following boxes:

• Node Layout—Preprovisions the slots in CTC for the cards required by the network plan. Choose 
this option when no DWDM cards are installed. (Errors will occur if cards are installed or the slots 
are preprovisioned.) Preprovisioning the slots before the physical cards are installed ensures that 
card installers place the cards in the correct slots. Preprovisioning the slots is also useful if you want 
to set up the network prior to card installation.

• Card Parameters—If checked, provisions the following parameters, if the cards are installed.
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– TXP, MXP, GE_XP, 10GE_XP and ADM-10G cards—Provisions the OTN and FEC 
parameters.

– OPT-AMP-L, OPT-AMP-17-C, OPT-AMP-C, GE_XP and 10GE_XP cards—Provisions the 
card mode.

• Pluggable Port Modules— If checked, allows the provisioning of PPMs on TXP, MXP, GE_XP, 
10GE_XP and ADM-10G cards, including PPM payloads.

• Internal Patchcords—If checked, allows the creation of OCH trunk to OCH filter patchcords 
between TXP, MXP, GE_XP, 10GE_XP, and ADM-10G card trunk ports, and the OCH card filter 
port.

• Optical Sides—If checked, allows the provisioning of optical sides.

• ANS Parameters—If checked, installs the ANS parameters. ANS parameters provision the values 
required for the node to function within the specified network design. ANS parameters include span 
losses, optical power, optics thresholds, amplifier working mode, gain, tilt, and many others. Refer 
to the “Node Reference” chapter in the Cisco ONS 15454 DWDM Reference Manual for a list of 
ONS 15454 ANS parameters.

Note If you are importing the Cisco TransportPlanner configuration file for the first time, you 
normally choose all available options.

• Skip Interactive Mode—If checked, CTC provisions all the chosen setup components automatically 
without allowing you to view the results after each one.

Step 10 Click Next. If you chose Skip Interactive Mode, continue with Step 11. If not, the wizard page that 
appears depends on the options chosen in Step 9: Complete the steps shown in Table 3-2 for each option.
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Table 3-2 NE Update Wizard Options

NE Update Function

Node Layout View the cards and slots on the left side of the page and verify that they are the same as the layout in 
the Cisco TransportPlanner Shelf Layout (see Table 3-1 on page 3-3). If the cards and slots match, 
click Apply. If not, click Cancel. and contact your next level of support to verify that you have the 
correct node setup file. If the site has a multishelf configuration, click Next and repeat this step for 
each shelf at the site.

CTC preprovisions the slots. (This might take a few seconds.) The results appear in the Log window. 
Slots that are successfully provisioned display an “Applied” status. A “Slot not empty” status appears 
if slots cannot be provisioned because a card is physically installed or the slot is already provisioned. 
If this occurs, complete the following steps. Otherwise, continue with the next NE Update function.

1. Click Cancel, then click Yes in the confirmation dialog box. The slot preprovisioning does not 
revert when you click Cancel.

2. If a physical card is installed, remove it from the shelf. 

3. Perform one of the following steps: 

– Delete all the preprovisioned slots using the “DLP-G351 Delete a Card in CTC” task on 
page 3-47, then repeat Steps 2 through Step 10.

– Delete the slot where the Slot Not Empty error occurred using the “DLP-G351 Delete a Card 
in CTC” task on page 3-47. Complete the “DLP-G353 Preprovision a Single Slot” task on 
page 3-48 to provision the slot manually, then repeat Steps 2 through 10 making sure to 
uncheck the Provision Node Layout option in Step 9.

Note When you preprovision a slot, the card is purple in the CTC shelf graphic and “NP” (not 
present) appears on the card. After the physical card is installed, the card changes to white and 
“NP” is removed from the CTC shelf graphic.

Card Parameters 1. Review the OTN, FEC, and card mode settings for each TXP, MXP, GE_XP, and 10GE_XP card.

2. Click Apply.

3. Click Next.

Pluggable Port 
Modules

1. Review the PPM settings for each TXP, MXP, GE_XP, and 10GE_XP card.

2. Click Apply.

3. Click Next.

Internal Patchcords 1. Review the internal patchcords. 

2. Click Apply.

3. Click Next.

Optical Sides 1. Review the optical side assignments. 

2. Click Apply.

3. Click Next.

ANS Parameters 1. Review the ANS parameters on the left half of the page.

c. Click Apply. The log file displays the results. At the end, a Done status will appear. If a parameter 
could not be applied, a Setting Refused status appears. If this occurs, contact your next level of 
support.
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Step 11 Click Finish, then click OK in the Wizard Complete confirmation dialog box.

Note Common control cards are not provisioned by Cisco TransportPlanner.

Stop. You have completed this procedure.

DLP-G351 Delete a Card in CTC

Note It is recommended that the card be physically removed from its slot before deleting it from CTC.

Step 1 Verify that the following conditions are not present. (During node turn-up, these conditions are normally 
not present):

• The card is a TCC2/TCC2P card. 

• The card is part of a protection group.

• The card has optical channels or overhead circuits provisioned.

• The card is being used for timing.

• The card has an OSC/GCC termination.

• A port on the card is being used for a Link Management Protocol (LMP) channel or link.

If any of these conditions exist, do not continue. You will not be able to delete the card until the card is 
removed from protection groups; circuits, DCC, and GCCs are deleted; a different timing source is 
provisioned, and the LMP link or channel is deleted.

• To replace a TCC2/TCC2P card, refer to the Cisco ONS 15454 DWDM Troubleshooting Guide. 

• To delete a protection group, see the “NTP-G83 Modify or Delete Card Protection Settings” 
procedure on page 10-37.

• To delete optical channels see the “DLP-G347 Delete Optical Channel Client Connections” task on 
page 7-10 and the “DLP-G106 Delete Optical Channel Network Connections” task on page 7-23; to 
delete overhead circuits, see the “DLP-G112 Delete Overhead Circuits” task on page 7-65. 

• To remove the card as a timing source, see the “NTP-G87 Change Node Timing Parameters” 
procedure on page 10-50.

• To remove OSC or GCC terminations, see the “NTP-G85 Modify or Delete OSC Terminations, 
DCC/GCC Terminations, and Provisionable Patchcords” procedure on page 10-45.

Purpose This task deletes a card from an ONS 15454 slot that is provisioned in 
CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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• To delete LMP channels or links, see “NTP-G164 Configure Link Management Protocol” procedure 
on page 6-18.

• To remove a DWDM patchcord, see DLP-G355 Delete an Internal Patchcord, page 3-102.

• To remove an optical side, see DLP-G480 Delete an Optical Side, page 3-104.

Step 2 On the shelf graphic in CTC, right-click the card that you want to remove and choose Delete Card. 

Step 3 Return to your originating procedure (NTP). 

DLP-G353 Preprovision a Single Slot

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), right-click an empty slot where 
you will install a card.

Step 2 From the Add Card shortcut menu, choose the card type that will be installed based on the 
Cisco TransportPlanner shelf layout (see Table 3-1 on page 3-3). Only cards that can be installed in the 
slot appear in the Add Card shortcut menu. The OPT-AMP-L, 32WSS, 32MUX-O, and 32DMX-O cards 
require two vacant slots, or they will not appear in the shortcut menu. Table 3-3 shows the Add Card 
shortcut menu items and submenu items, and the card groups and menu options/cards that they reference. 

Purpose This task preprovisions a single ONS 15454 slot in CTC. Preprovisioning 
of all the slots in the shelf is normally performed when you complete the 
“NTP-G143 Import the Cisco TransportPlanner NE Update Configuration 
File” procedure on page 3-43. Use this task if you need to manually 
preprovision a single slot. All slot preprovisioning must be based upon the 
Cisco TransportPlanner shelf layout prepared for your site. 

Tools/Equipment Cisco TransportPlanner shelf layout table or JPG file.

Prerequisite Procedures NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 3-3 CTC Add Card Shortcut Menu for DWDM Cards

Menu Item
Submenu 
Category Card Group Submenu Item 1 Submenu Item 2 Card(s)

DWDM nXP Transponder and 
Muxponder

— 10GE_XP 10GE_XP

— ADM-10G ADM-10G

— GE_XP GE_XP

— MXPP_MR_2.5G MXPP_MR_2.5G

— MXP_2.5G_10E MXP_2.5G_10E

MXP_2.5G_10E_C

MXP_2.5G_10E_L

— MXP_2.5G_10G MXP_2.5G_10G

— MXP_MR_10DME MXP_MR_10DME_C

MXP_MR_10DME_L

— MXP_MR_2.5G MXP_MR_2.5G

— TXPP_MR_2.5G TXPP_MR_2.5G

— TXP_MR_10E TXP_MR_10E

TXP_MR_10E_C

TXP_MR_10E_L

— TXP_MR_10G TXP_MR_10G

— TXP_MR_2.5G TXP_MR_2.5G

MD Multiplexer and 
Demultiplexer

C Band 32 DMXO 32DMX-O

40 WSS 40-WSS-C or 40-WSS-CE

32 MUXO 32MUX-O

32 WSS 32WSS

4MD 4MD-xx.x

32 DMX 32DMX

40-MUX-C 40-MUX-C

32 MUXO 32MUX-O

40-DMX-C, or
40-DMX-CE

40-DMX-C, or
40-DMX-CE

L Band 32 WSS L 32WSS-L

32 DMXL 32DMX-L

WXC Cross-connect C Band 40 WXC 40-WXC-C

OSC Optical Service 
Channel

— MMU MMU

— OSC-CSM OSC-CSM
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Note When you preprovision a slot, the card appears purple in the CTC shelf graphic (the card appears 
as white when a card is installed in the slot). NP on the card graphic indicates that the card is not 
physically installed.

Step 3 Repeat Step 2 until all the cards shown in the Cisco TransportPlanner shelf layout are provisioned in 
CTC.

Stop. You have completed this procedure.

DWDM OADM Optical Add/Drop 
Multiplexer

— AD-1B AD-1B-xx.x

— AD-1C AD-1C-xx.x

— AD-2C AD-2C-xx.x

— AD-4B AD-4B-xx.x

— AD-4C AD-4C-xx.x

Ampli Optical Amplifier C Band OPT-AMP-17-C OPT-AMP-17-C

OPT-AMP-C OPT-AMP-C

OPT-PRE OPT-PRE

OPT-BST OPT-BST

OPT-BST E OPT-BST-E

L Band OPT-BST L OPT-BST-L

OPT-AMP L OPT-AMP-L

Ethernet — — — MS-ISC-100T MS-ISC-100T

G1000 G1000

OSCM — — — — OSCM (Slots 8 and 10 only)

Table 3-3 CTC Add Card Shortcut Menu for DWDM Cards (continued)

Menu Item
Submenu 
Category Card Group Submenu Item 1 Submenu Item 2 Card(s)
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NTP-G320 Configure the Node as a Non-DWDM Network

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 2 From the Selector area, select Network Type.

Step 3 Choose Not-DWDM, from the Value drop-down list. Click Apply.

Step 4 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Port Status tabs.

Step 5 Click the Launch ANS button. The relevant ports in the node will be in IS state.

Step 6 Click OK.

Step 7 Return to your originating procedure (NTP).

DLP-G693 Configure the Amplifier

Step 1 Display the amplifier card in card view.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Select the working mode from the Card Working Mode drop-down list.

Step 4 Change to node view (single-shelf mode) or multishelf view (multishelf mode), then click the 
Provisioning > WDM-ANS > Provisioning tabs. 

Step 5 From the Selector area, select the amplifier slot. If the default parameters are present, continue with 
Step 6. If not, click Add to add the Channel LOS Threshold, Amplifier Tilt, Power, and Amplifier 
Working Mode parameters. To add the ANS parameters, see the “DLP-G541 Add an ANS Parameter” 
task on page 14-60 for instructions.

Purpose This tasks configures a node as a Non-DWDM network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task configures the optical parameters and threshold values of the 
amplifier card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Click the value of the ANS parameter that you want to modify and enter the new value specified in 
Table 3-4. To modify the ANS parameters, see the “DLP-G681 Modify an ANS Parameter” task on 
page 14-61 for instructions.

Step 7 Click Apply.

Step 8 Click the Provisioning > WDM-ANS > Port Status tabs.

Step 9 Click Launch ANS.

Step 10 In the Apply Launch ANS dialog box, click Yes.

Step 11 In the Launch ANS confirmation dialog box, click OK.

Step 12 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 13 Verify the following in the Results column:

• Success - Changed —The parameter has been successfully changed with the ports in IS.

Step 14 Verify that the Set By column displays t he value “ANS” or “APC” as the application that sets the 
ANS parameter.

Step 15 Return to your originating procedure (NTP).

DLP-G694 Configure the PSM

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 2 From the Selector area, select the PSM slot. If the default parameters are present, continue with Step 3. 
If not, click Add to add the Channel LOS Threshold and VOA Attenuation parameters. To add the ANS 
parameters, see the “DLP-G541 Add an ANS Parameter” task on page 14-60 for instructions.

Table 3-4 Values for the ANS Parameters (amplifier)

Port ANS Parameter Value

Slot 16 (OPT-AMP C).Port COM-RX Channel LOS Threshold 35.0 dBm

Slot 16 (OPT-AMP C).Port LINE-TX Amplifier Working Mode Control Gain

Slot 16 (OPT-AMP C).Port LINE-TX Amplifier Tilt 0.0 dB

Slot 16 (OPT-AMP C).Port LINE-TX Power 1.0 dBm

Purpose This tasks configures the PSM behavior.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Click the value of the ANS parameter that you want to modify and enter the new value specified in 
Table 3-4. To modify the ANS parameters, see the “DLP-G681 Modify an ANS Parameter” task on 
page 14-61 for instructions.

Step 4 Click Apply.

Step 5 Click the Provisioning > WDM-ANS > Port Status tabs.

Step 6 Click Launch ANS.

Step 7 In the Apply Launch ANS dialog box, click Yes.

Step 8 In the Launch ANS confirmation dialog box, click OK.

Step 9 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.

Step 10 Verify the following in the Results column:

• Success - Changed —The parameter has been successfully changed with the ports in IS.

Step 11 Verify that the Set By column displays t he value “ANS” or “APC” as the application that sets the 
ANS parameter.

Step 12 Return to your originating procedure (NTP).

Table 3-5 Values for the ANS Parameters (PSM)

Port ANS Parameter Value

Slot 14(PSM).Port W-RX VOA Attenuation 3.0 dB

Slot 14(PSM).Port W-RX Channel LOS Threshold 15.0 dB

Slot 14(PSM).Port P-RX VOA Attenuation 10.0 dB

Slot 14(PSM).Port P-RX Channel LOS Threshold 20.0 dB
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NTP-G30 Install the DWDM Cards

Warning This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar 
with standard practices for preventing accidents. To see translations of the warnings that appear in 
this publication, refer to the Regulatory Compliance and Safety Information document for the 
appropriate Cisco chassis. Statement 274

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Purpose This procedure describes how to install the DWDM multiplexer, 
demultiplexer, wavelength selective switch, wavelength cross-connect, 
OADM, OSC, and optical amplifier cards. 

Tools/Equipment Cisco TransportPlanner shelf layout 

The following cards, as required by your site plan:

• C Band: OPT-PRE, OPT-BST, OPT-BST-E, 32MUX-O, 40-MUX-C, 
32DMX-O, 32DMX, 40-DMX-C, 40-DMX-CE, 32WSS, 40-WSS-C, 
40-WSS-CE, 40-WXC-C, OPT-AMP-17-C, OPT-AMP-C, MMU, 
4MD-xx.x, AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, 
AD-4B-xx.x, OSCM, and OSC-CSM cards (as applicable), or

• L Band: 40-WXC-C-L, 32WSS-L, 32DMX-L, OPT-BST-L, 
OPT-AMP-L

The ONS 15454 NE defaults file if the node will use custom NE defaults

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-76

NTP-G14 Install DWDM Equipment, page 1-68

NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

NTP-G143 Import the Cisco TransportPlanner NE Update Configuration 
File, page 3-43

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Warning High-performance devices on this card can get hot during operation. To remove the card, hold it by 
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before 
placing it in an antistatic bag. Statement 201

Caution Always use the supplied electrostatic discharge (ESD) wristband when working with a powered 
ONS 15454. Plug the wristband cable into the ESD jack located on the lower-right outside edge of the 
shelf assembly.

Note For United States installations, complies with the United States Federal Drug Administration Code of 
Federal Regulations Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser 
Notice No. 50, dated July 26, 2001. 

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 If the node requires a custom NE default settings to be installed on the node, complete the “NTP-G136 
Import Network Element Defaults” procedure on page 13-43. If not, continue with Step 2. (For 
information about the ONS 15454 NE defaults, refer to the “Network Elements Defaults” appendix in 
the Cisco ONS 15454 DWDM Reference Manual.)

Caution If custom NE defaults are required, they must be installed before you install the DWDM cards.

Step 2 Verify that you have one of the following guides for the DWDM card installation:

• The slots that were preprovisioned when you completed the “NTP-G143 Import the Cisco 
TransportPlanner NE Update Configuration File” procedure on page 3-43. 

• The Cisco TransportPlanner shelf layout report (see Table 3-1 on page 3-3). 

Step 3 If the slots are preprovisioned, continue with Step 4. If you are using the Cisco TransportPlanner shelf 
layout report, complete the “DLP-G348 Use the Cisco TransportPlanner Shelf Layout Report” task on 
page 3-57.

Step 4 Remove a DWDM card from its packaging, then remove the protective caps from the backplane 
connectors. (Safety caps are typically yellow.)

Step 5 Open the card latches/ejectors. 

Step 6 Use the latches/ejectors to firmly slide the card along the slot guide rails until the card plugs into the 
receptacle at the back of the slot. The correct slot is designated by the Cisco TransportPlanner shelf 
layout.

Step 7 Verify that the card is inserted correctly. Simultaneously close the latches/ejectors on the card.
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Note It is possible to close the latches/ejectors when the card is not completely plugged in. Ensure 
that you cannot insert the card any further.

After installing the card, the following LED activity will occur:

• The card’s LEDs will go through a sequence of activities (turn on, turn off, blinking.) This will take 
2 to 3 minutes. 

• The ACT LED turns on. 

• The signal fail (SF) LED might persist until all card ports connect to their far-end counterparts and 
a signal is present.

Step 8 If the card does not boot up properly, or the LED activity is not similar to the activity in Step 7, check 
the following:

• When a physical card type does not match the type of card provisioned for that slot in CTC, the card 
might not boot. If a DWDM card does not boot, open CTC and ensure that the slot is not provisioned 
for a different card type before assuming that the card is faulty.

• If the red FAIL LED does not turn on, check the power. 

• If you insert a card into a slot provisioned for a different card, all LEDs turn off and a minor 
equipment mismatch alarm appears on the CTC Alarms tab.

• If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed.

If any of conditions are present, remove the card and repeat Steps 4 to 7. If the card does not boot up 
properly the second time, it might be defective. Contact your next level of support.

Step 9 Repeat Steps 5 through 8 until all the DWDM cards are installed in the node.

Step 10 If an OPT-PRE card (or the OPT-AMP-L, OPT-AMP-17-C, or OPT-AMP-C card in OPT-PRE card 
mode) are installed, complete one of the following steps for each OPT-PRE card based on the Cisco 
TransportPlanner shelf layout. If an OPT-PRE is not installed, you have completed this procedure.

• If the Cisco TransportPlanner shelf layout does not include DCUs, install a patchcord and 4-dB 
attenuator with a tolerance of +/–1 dB between the DC TX and RX ports of all OPT-PRE or 
OPT-AMP-L DC TX and RX ports for each OPT-PRE or OPT-AMP-L card installed in the shelf.

• If the shelf layout includes DCUs, complete the “NTP-G31 Install the DWDM Dispersion 
Compensating Units” procedure on page 3-58 for each side of the shelf that requires a DCU.

Stop. You have completed this procedure. 
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DLP-G348 Use the Cisco TransportPlanner Shelf Layout Report

Step 1 Display the Cisco TransportPlanner shelf layout report for your site. The report can be viewed in 
Cisco TransportPlanner (see Figure 3-9). It can also be viewed as a JPEG graphic. Refer to the 
Cisco TransportPlanner DWDM Operations Guide for information about generating shelf layout 
reports.

Figure 3-9 Cisco TransportPlanner Shelf Layout Report Displayed in Cisco TransportPlanner

Step 2 Review the following installation information:

• Rack—Indicates the rack in the node where the cards must be installed.

• Shelf—Indicates the shelf in the rack where the cards must be installed. Shelf options include:

– Flex Shelf—The ONS 15216 FlexLayer mechanical shelf houses Y-cable modules. Flex shelf 
positions are numbered 1 to 4 from left to right.

– DCU Shelf—The Cisco ONS 15216 dispersion compensation shelf assembly houses DCUs. 
DCU positions are numbered 1 to 2 from left to right.

Purpose This task describes how to use the Cisco TransportPlanner shelf layout 
report to install cards in a DWDM node.

Tools/Equipment None

Prerequisite Procedures NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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– Shelf-ANSI-n or Shelf-ETSI-n—The ONS 15454 shelf assembly houses ONS 15454 common, 
DWDM, and client cards. Positions in this type of shelf are numbered 1 to 17 from left to right. 
Multiple shelves might appear.

• Slot—Indicates the slot in the specific shelf where the cards must be installed:

– Unit Name (Product ID)— Identifies the card by its Product ID.

– Unit Description—Identifies the card by its name.

• Unit Side—Identifies the side of the node that the specific card is serving: A, B, C, D, E, F, G, or H.

• Unit Plug-in Modules—Identifies the type and number of PPMs that will be used with specific TXP, 
MXP, GE_XP, or 10GE_XP cards.

Step 3 Return to your originating procedure (NTP).

NTP-G31 Install the DWDM Dispersion Compensating Units

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right side of the shelf assembly.

Note For US installations, complies with the US Federal Drug Administration Code of Federal Regulations 
Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Purpose This procedure describes how to install the DCUs for DWDM shelves.

Tools/Equipment DCUs

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-76

NTP-G14 Install DWDM Equipment, page 1-68

NTP-G30 Install the DWDM Cards, page 3-54

NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 1 Remove the DCU from its packaging, then remove the protective caps from the connectors. (Safety caps 
are typically yellow.)

Step 2 Use both hands to push the DCU all the way into the chassis until the connector spring lock on the right 
side of the module clicks into place. 

Step 3 Open the cover with the laser warning on the connector adapter and then connect the cable connector.

Note The Side A DCU is commonly installed on the left side and the Side B DCU is commonly 
installed on the right side.

Note Double-check the placement of the DCU card(s) with your Cisco TransportPlanner shelf layout. 
If you install the wrong DCU in a slot, remove the DCU and install the correct one.

Stop. You have completed this procedure. 

NTP-G179 Install the TXP, MXP, GE_XP, 10GE_XP, and ADM-10G 
Cards 

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Warning Class 1 laser product. Statement 1008

Purpose This procedure describes how to install the ONS 15454 TXP, MXP, 
GE_XP, 10GE_XP, and ADM-10G cards.

Tools/Equipment TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, 
TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, MXPP_2.5G_10G, 
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, 
MXP_MR_2.5G, MXP_MR_10DME_C, MXP_MR_10DME_L, 
10GE_XP, GE_XP, or ADM-10G cards (as applicable)

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-76

NTP-G14 Install DWDM Equipment, page 1-68

NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not view directly with optical instruments. Viewing the laser output with certain optical instruments 
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye 
hazard. Statement 1056

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note For US installations, complies with the US Federal Drug Administration Code of Federal Regulations 
Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 Display the Cisco TransportPlanner shelf layout (see Table 3-1 on page 3-3) for the node where you will 
install the card.

Step 2 Remove the card from its packaging, then remove the protective clips from the backplane connectors.

Step 3 Open the card latches/ejectors. 

Step 4 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot designated by the Cisco TransportPlanner shelf layout.

Step 5 Verify that the card is inserted correctly and simultaneously close the latches/ejectors on the card.

Note It is possible to close the latches and ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Note If you install the card in the wrong slot, CTC will raise a MEA (EQPT) alarm. To clear this 
alarm, open the latches, slide the card out, then insert it in the correct slot. 

After you install the card, the FAIL, ACT, and SF LEDs will go through a sequence of activities. They 
will turn on, turn off, and blink at different points. After approximately 2 to 3 minutes, the ACT or 
ACT/STBY LED turns on. The SF LED might persist until all card ports connect to their far-end 
counterparts and a signal is present.
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Note Until a card is provisioned, the card is in the standby condition and the ACT/STBY LED remains 
amber in color.

Step 6 If the card does not boot up properly or the LEDs do not progress through the activities described in 
Step 5, check the following:

• When a physical card type does not match the type of card provisioned for that slot in CTC, the card 
might not boot and CTC will show a MEA (EQPT) alarm. If the card does not boot, open CTC and 
ensure that the slot is not provisioned for a different card type before assuming that the card is faulty.

• If the red FAIL LED does not turn on, check the power.

• If you insert a card into a slot provisioned for a different card, all LEDs turn off.

• If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed 
properly.

If any of these conditions are present, remove the card and repeat Steps 3 to 5. If the card does not boot 
up properly the second time, contact your next level of support.

Step 7 If the card requires a Small Form-factor Pluggable (SFP or XFP) connector, complete one of the 
following tasks:

• DLP-G63 Install an SFP or XFP, page 3-62—Complete this task to install the physical SFP or XFP 
into the TXP, MXP, GE_XP, 10GE_XP, or ADM-10G card.

• DLP-G273 Preprovision an SFP or XFP Slot, page 3-63—(Optional) Complete this task if you do 
not have the physical SFP or XFP and need to preprovision the SFP or XFP slot. 

Note SFPs/XFPs are hot-swappable input/output devices that plug into a TXP, MXP, GE_XP, 
10GE_XP, ADM-10G, or line card port to link the port with the fiber-optic network. For more 
information about SFPs and XFPs, refer to For more information, refer to the Cisco ONS 15454 
DWDM Reference Manual and the Installing GBIC, SFP, and XFP Optics Modules in ONS 
Platforms document.

Note PPM provisioning determines how the SFPs and XFPs are used in CTC. PPM provisioning 
procedures are provided in Chapter 5, “Provision Transponder and Muxponder Cards.”

Step 8 If you need to remove an SFP or XFP, complete the “DLP-G64 Remove an SFP or XFP” task on 
page 3-64.

Note You will provision the TXP, MXP, GE_XP, 10GE_XP, or ADM-10G cards after you complete all node 
turn-up procedures. TXP and MXP provisioning procedures are provided in Chapter 5, “Provision 
Transponder and Muxponder Cards.”

Note Until a card is provisioned, the card is in the standby condition and the ACT/STBY LED remains amber 
in color.

Stop. You have completed this procedure. 
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Warning The intrabuilding ports of the ONS 15454 are suitable for connection to intrabuilding or unexposed 
wiring or cabling only. The intrabuilding ports of the ONS 15454 must not be metallically connected 
to interfaces that connect to the OSP or its wiring. These interfaces are designed for use as 
intrabuilding interfaces only (Type 2 or Type 4 ports as described in GR-1089-CORE, Issue 4), and 
require isolation from the exposed OSP cabling. The addition of Primary Protectors is not sufficient 
protection while connecting these interfaces metallically to the OSP wiring.

Warning The intrabuilding ports of the ONS 15454 are suitable for connection only to shielded intrabuilding 
cabling, grounded at both ends.

Note The CC-FTA fan tray is mandatory if CWDM SFPs and DWDM SFPs are used on MSTP units.

Note SFPs and XFPs are hot-swappable input/output devices that plug into a TXP, MXP, GE_XP, 10GE_XP, 
or ADM-10G port to link the port with the fiber-optic network. For more information, refer to the 
Cisco ONS 15454 DWDM Reference Manual and the Installing GBIC, SFP, and XFP Optics Modules in 
ONS Platforms document.

Note If you have installed a fan tray lower than CC-FTA on the MSTP unit, you must have the transponder 
cards (TXP_MR_10E, TXP_MR_10E_C, or TXP_MR_10E_L) installed in Slot 5, 6, 12, or 13. This 
limitation does not exist for fan-tray versions higher than CC-FTA.

Note SFPs and XFPs are generically called PPMs in CTC. After installing multirate SFPs or XFPs, multirate 
PPMs must be provisioned in CTC. To complete the provisioning of the pluggable port, complete the 
“DLP-G277 Provision a Multirate PPM” task on page 5-9. 

Step 1 Verify that the SFP or XFP is correct for your network and TXP, MXP, GE_XP, 10GE_XP, or ADM-10G 
card (see the “Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Reference 
Manual for card and SFP/XFP compatibility information). Check that you are installing compatible 
SFPs or XFPs, for example, SX to SX or LX/LH to LX/LH. 

Step 2 Install the SFP or XFP:

Purpose This task installs SFPs and XFPs into TXP, MXP, GE_XP, 10GE_XP and 
ADM-10G cards. SFPs and XFPs provide a fiber interface to the card. 

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, GE_XP, 10GE_XP, and ADM-10G 
Cards, page 3-59

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• For a mylar tab SFP or XFP: Slide the SFP or XFP into the slot.

• For an actuator/button SFP or XFP: Slide the SFP or XFP all the way into the slot until you hear a 
click.

• For a bail clasp SFP or XFP: Latch (flip upwards) the bail clasp before inserting the SFP or XFP 
into the slot and then slide it into the slot. 

Note SFP and XFPs are keyed to prevent incorrect installation.

Step 3 Do not remove the protective caps from the SFP or XFP until you are ready to attach the network 
fiber-optic cable. 

Step 4 Return to your originating procedure (NTP).

DLP-G273 Preprovision an SFP or XFP Slot

Note SFPs and XFPs are generically called PPMs in CTC. After installing multirate SFPs or XFPs, multirate 
PPMs must be provisioned in CTC.

Step 1 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP, MXP, GE_XP, 
10GE_XP, or ADM-10G card where you want to provision PPM settings. 

Step 2 Click the Provisioning > Pluggable Port Modules tabs. 

Step 3 In the Pluggable Port Modules area, click Create. The Create PPM dialog box appears.

Step 4 In the Create PPM dialog box, complete the following:

• PPM—Choose the PPM slot number where the SFP or XFP is installed from the drop-down list.

• PPM Type—Choose the number of ports supported by your SFP or XFP from the drop-down list. 
The drop-down list displays the number of PPMs that are available for provisioning. If only one port 
is supported, PPM (1 port) is the only option. 

Step 5 Click OK. The newly created port appears in the Pluggable Port Modules pane. The row in the Pluggable 
Port Modules pane turns light blue. The Actual Equipment Type column remains blank until the actual 
SFP or XFP is installed. After the SFP or XFP is installed, the row in the pane turns white and the 
Actual Equipment Type column shows the equipment name.

Step 6 Verify that the PPM appears in the list in the Pluggable Port Modules pane. If it does not, repeat Steps 3 
through 5. 

Step 7 Repeat the task to provision a second PPM, if needed. If not, continue with Step 8.

Purpose This task preprovisions SFPs and XFPs, which connect fiber to TXP, MXP, 
GE_XP, 10GE_XP, and ADM-10G cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 Click OK.

Step 9 Return to your originating procedure (NTP). 

DLP-G64 Remove an SFP or XFP

Note This task removes the SFP or XFP hardware. To delete the provisioning for an SFP or XFP, see the 
“DLP-G280 Delete a PPM” procedure on page 5-16.

Step 1 If a fiber is connected, disconnect the network fiber cable from the SFP or XFP LC-type connector.

Step 2 Release the SFP or XFP from the slot by performing one of the following actions (depending which latch 
is on the SFP or XFP): 

• For a mylar tab SFP or XFP: Pull out the mylar tab. 

• For an actuator/button SFP or XFP: Press the actuator/button.

• For a bail clasp SFP or XFP: Unlatch the bail clasp and swing it downward.

Step 3 Slide the SFP or XFP out of the slot.

Step 4 Return to your originating procedure (NTP).

Note Removing an SFP from the client ports of a Y-cable protection group card causes an IMPROPRMVL 
(PPM) alarm. The working port raises the CR,IMPROPRMVL,SA alarm and the protected port raises 
the MN,IMPROPRMVL,NSA alarm. The severity on the client ports is changed according to the 
protection switch state.

Purpose This task removes SFPs and XFPs from TXP, MXP, GE_XP, 10GE_XP, 
and ADM-10G cards.

Tools/Equipment None

Prerequisite Procedures NTP-G179 Install the TXP, MXP, GE_XP, 10GE_XP, and ADM-10G 
Cards, page 3-59

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-G123 Install the Filler Cards

Warning Blank faceplates (filler panels) serve three important functions: they prevent exposure to hazardous 
voltages and currents inside the chassis; they contain electromagnetic interference (EMI) that might 
disrupt other equipment; and they direct the flow of cooling air through the chassis. Do not operate 
the system unless all cards and faceplates are in place. Statement 156

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower right outside edge of the shelf assembly and ensure the shelf 
assembly is properly grounded.

Step 1 Open the card ejectors. 

Step 2 Slide the card along the guide rails into the correct slot.

Step 3 Close the ejectors.

Step 4 Repeat for any remaining unused card slots. 

Stop. You have completed this procedure. 

Purpose This procedure explains how to install the filler cards (blank faceplates) in 
any unused traffic or AIC-I card slots (Slots 1 through 6, 9, and 11 through 
17). The filler card aids in maintaining proper air flow and electro-magnetic 
interference (EMI) requirements and is detected by CTC in 
Software Release 6.0 and later.

Tools/Equipment Filler cards (Cisco P/N 15454-FILLER)

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-54

NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-58

NTP-G179 Install the TXP, MXP, GE_XP, 10GE_XP, and ADM-10G 
Cards, page 3-59

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs

Warning Class I (CDRH) and Class 1M (IEC) laser products. Statement 1055

Note For US installations, complies with the US Federal Drug Administration Code of Federal Regulations 
Title 21, Sections 1040.10 and 1040.11, except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Note In this procedure, you will generally connect fibers in an Side B-to-Side A or Side B-to-Side B pattern 
only. “Side A” refers to cards and ports in Slots 1 through 8. “Side B” refers to cards and ports installed 
in Slots 10 through 17.

Note You will install fiber-optic cables on TXP, MXP, GE_XP, 10GE_XP, and ADM-10G cards later in the 
chapter during the “NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or ROADM Nodes” 
procedure on page 3-72.

Step 1 Refer to the “DLP-G349 Use the Cisco TransportPlanner Internal Connections Report” task on 
page 3-68 to install cables to the DWDM cards.

Step 2 Verify that the appropriate fiber optic cables are available to complete the connections shown in the 
Cisco TransportPlanner Internal Connections report:

a. Count the number of connections listed in the Internal Connections and verify that you have the 
same number of cables.

b. Measure the distance between Origination Position and Destination Position for each connection, 
then verify that the fiber lengths will fit each one.

Step 3 Complete the “NTP-G115 Clean Fiber Connectors” procedure on page 13-26 for all fiber connections, 
even new fiber. Dust particles can degrade performance. Put caps on any fiber connectors that are not 
used.

Step 4 On the front of the fiber-storage tray (usually installed below the node you are fibering), push the tabs 
on the left and right sides inward to release the lock on the tray. 

Purpose This procedure attaches fiber-optic cables on the DWDM cards and DCUs.

Tools/Equipment Fiber-optic cables

Cisco TransportPlanner Internal Connections Report

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-54

NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-58 
(as applicable)

NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 5 Pull the fiber-storage tray away from the shelf until it is fully opened.

Step 6 Open the fold-down door that at the bottom of the shelf assembly to expose the cable-routing channel 
(Figure 3-10).

Figure 3-10 Managing Cables on the Front Panel 

Step 7 Using the Cisco TransportPlanner Internal Connections Report, connect one end of the fiber cable plug 
into the Origination Position.

Step 8 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. (Fiber clips 
are factory-attached to the faceplates of 32MUX-O, 32DMX, 32DMX-O, OSCM, OSC-CSM, OPT-PRE, 
OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-17-C, and OPT-AMP-C cards.)

Step 9 Route the fiber cable through the cable-routing channel and cutout on the appropriate side of the shelf 
assembly, as necessary.

Step 10 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray 
(Figure 3-11).

Figure 3-11 Fiber-Storage Tray
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Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 11 Route the fiber cable out either side of the fiber-storage tray as necessary. 

Step 12 Plug the other end of the cable into the Destination position.

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
OSC Terminations” procedure on page 3-105) if transmit and receive fibers are not connected 
correctly. For example, an RX port is connected to another RX port or a TX port is connected to 
another TX port. 

Step 13 Repeat Steps 4 through 12 until you have connected the intra-shelf fibers according to the 
Cisco TransportPlanner Internal Connections report.

Step 14 To close the fiber-storage tray, push the tray back toward the rack until it locks into place.

Stop. You have completed this procedure. 

DLP-G349 Use the Cisco TransportPlanner Internal Connections Report

Step 1 Display the Cisco TransportPlanner Internal Connections report for the node that you are provisioning. 
The Internal Connections report is presented in two views, a patchcord installation view and a software 
provisioning view. The Patchcord installation view lists all the patchcord connections that the installer 
has to mechanically cable within the site between the different ports of the DWDM cards. Figure 3-12 
on page 3-70 shows an example patchcord installation view. The SW Provisioning view contains all the 
connections to be manually set or removed via CTC with respect to the default connections that are 
automatically generated by the system software running on the node. Figure 3-13 on page 3-71 shows 
an example of a software provisioning view. 

The tables identify the patchcords that you must cable by their endpoints. Starting from the left side of 
report, Position identifies the fiber origination point the location shown in the next Position to right is 
the destination point for the fiber connection. The patchcord endpoints are identified by site, assembly 
shelf, slot, and port number. Information provided by the Internal Connections Software report includes:

• Name—Displays the name of the site.On the SW provisioning view, this column indicates whether 
the connection was automatically set, or should be manually set or removed via CTC.

Purpose This task describes how to use the Cisco TransportPlanner Internal 
Connections report to install cables on the DWDM cards.

Tools/Equipment None

Prerequisite Procedures NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• Position—The cable origination in the format is Rack.Shelf.Slot. For example, Rack#1.Shelf 
Assembly 1.Slot 2 refers to Slot 2 in shelf assembly 1(DWDM) shelf of Rack 1. Refer to the Cisco 
TransportPlanner Site Dialog box for rack and shelf names and locations. 

• Unit—The ONS 15454 DWDM card (unit) that is installed in the Position’s slot. This is where the 
patchcord originates.

• Port Number—The port number where the patchcord connection originates.

• Port ID—(Software provisioning view only) The port identifier shown in TL1 for the Position-1 
connection.

• Port Label—The name of the physical port printed on the DWDM card’s front panel and shown in 
CTC card view.

• Attenuator—If attenuation is required, the product ID (PID) of the bulk fixed attenuator is shown. 
“Att-Lpbk-4dB” indicates that the DC TX and DC RX ports on an OPT-PRE (or OPT-AMP-L, 
OPT-AMP-17-C, or OPT-AMP-C card provisioned in OPT-PRE card mode) card are to be connected 
with an attenuated loopback that is shipped with the OPT-PRE card. This parameter also indicates 
when an internal attenuator must be placed between the OPT-PRE DC-TX and DC-RX ports on the 
when a DCU is equipped.

Note If the Attenuator field is blank, no attenuation is needed.

• Position—The cable termination in the format is Rack.Shelf.Slot.

• Unit—The ONS 15454 DWDM card that is installed in the Position’s slot. This is where the cabling 
terminates.

• Port—The port number where the patchcord connection terminates.

• Port ID—(Software provisioning view only) The port identifier shown in TL1 for the Position-2 
connection.

• Port Label—The name of the physical port printed on the DWDM card’s front panel and shown in 
CTC card view for the Position-2 connection.

• P/F—Indicates whether you must create the connection manually in CTC. A Yes appearing in this 
column means that you must create the connection manually.

Caution Failure to create the required manual connections will prevent the node from turning up properly.
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Figure 3-12 Cisco TransportPlanner Internal Connections Report—Patchcord Installation View
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Figure 3-13 Cisco TransportPlanner Internal Connections Report—Software Provisioning View

Step 2 Return to your originating procedure (NTP).
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NTP-G140 Install Fiber-Optic Cables Between Terminal, Hub, or 
ROADM Nodes

Step 1 Determine which type of node you are fibering. 

The following node types require the listed equipment. The cards and patch panels should already be 
installed before you begin this procedure.

• Terminal node: One 32DMX-O card, one 32MUX-O card, and one standard patch-panel tray or one 
deep patch-panel tray

• Hub node: Two 32DMX-O cards, two 32MUX-O cards, and two standard patch-panel trays or two 
deep patch-panel trays

• ROADM node: Two 32WSS cards, two 32DMX cards, and two standard patch-panel trays or two 
deep patch-panel trays

• Expanded ROADM node: Two 40-WSS-C/40-WSS-CE cards, two 40-DMX-C/40-DMX-CE cards, 
and two 40-channel patch-panel trays, preinstalled with MPO-LC cables

Note If you are using standard patch panels, you will also need eight multifiber push-on (MPO) 
cables per standard patch panel. MPO cables are fiber-optic cables terminated on one end 
with one MPO connector and on the other end with eight LC-type connectors. Deep 
patch-panel trays come pre-installed with MPO cables.

Step 2 On the front of the patch-panel tray, push the tabs on the left and right sides inward to release the lock 
on the tray. 

Step 3 Pull the patch-panel tray away from the shelf until it is fully opened. 

Note The red latch inside the patch-panel tray at the top left corner will automatically click and lock 
the tray in the open position when you have fully opened the tray.

Purpose This procedure routes fiber-optic cables from the DWDM optical cards in 
a terminal, hub, or ROADM node to the patch panel, and from the patch 
panel to TXP, MXP, GE_XP, 10GE_XP, or ADM-10G cards.

Tools/Equipment See Step 1 for a list of equipment specific to each node type.

All node types require fiber-optic cables, terminated with a single LC-type 
connector on each end.

Cisco TransportPlanner Internal Connections Report

Prerequisite Procedures DLP-G28 Install the Fiber Patch-Panel Tray, page 1-70

DLP-G29 Install the Fiber-Storage Tray, page 1-70

NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-66

DLP-G348 Use the Cisco TransportPlanner Shelf Layout Report, page 3-57

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 4 Depending on the type of patch-panel tray you are using:

• If you are using the standard patch-panel tray:

– Complete the “DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 
32MUX-O/32DMX-O Cards to the Standard Patch-Panel Tray” task on page 3-74.

– Complete the “DLP-G316 Install Fiber-Optic Cables from TXP, MXP, GE_XP, 10GE_XP, or 
ADM-10G Cards to the Standard Patch-Panel Tray” task on page 3-78.

• If you are using the deep patch-panel tray:

– Complete the “DLP-G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 
32MUX-O/32DMX-O Cards to the Deep Patch-Panel Tray” task on page 3-79.

– Complete the “DLP-G357 Install Fiber-Optic Cables from the TXP, MXP, GE_XP, 10GE_XP, 
or ADM-10G Cards to the Deep Patch-Panel Tray or 40-Channel Patch-Panel Tray” task on 
page 3-86.

• If you are using the 40-channel patch-panel tray:

– As needed, complete the “DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel 
Patch-Panel Tray” task on page 3-82 to route the MPO cables out of the right side of the tray so 
they can be easily connected to cards installed on the right side of the shelf 
(Slots 12 through 17).

– Complete the “DLP-G428 Install Fiber-Optic Cables from the 40-WSS-C/40-WSS-CE and 
40-DMX-C/40-DMX-CE Cards in an Expanded ROADM, Terminal, or Hub Node to the 
40-Channel Patch-Panel Tray” task on page 3-84

Step 5 To close the patch-panel tray, unlock it by pressing the red latch in the top left corner, and then push the 
tray back toward the rack until it locks into place.

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure that adequate cable slack remains.

Stop. You have completed this procedure.
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DLP-G315 Install Fiber-Optic Cables From the 32WSS/32DMX and 
32MUX-O/32DMX-O Cards to the Standard Patch-Panel Tray

Note For a ROADM or hub node, two patch panels will be used, one for Side B side and one for Side A. The 
Side B 32WSS/32DMX card will connect to the Side B patch panel. The Side A 32WSS/32DMX card 
will connect to the Side A patch panel.

Step 1 Choose either the Side B or Side A to cable the 32MUX-O and 32DMX-O cards (or the 32WSS and 
32DMX cards for a ROADM node).

Purpose This task describes how to route fiber-optic cables from 32MUX-O, 
32WSS, 32DMX-O, and 32DMX cards in a terminal, hub, or ROADM node 
to the standard patch panel.

Tools/Equipment The following node types require the following equipment. The cards and 
patch panels should already be installed before you begin this procedure.

Terminal node:

• One 32DMX-O card

• One 32MUX-O card

• One standard patch-panel tray

• Eight fiber-optic MPO cables: each MPO cable is terminated on one 
end with one MPO connector and on the other end with eight LC-type 
connectors

Hub node:

• Two 32DMX-O cards

• Two 32MUX-O cards

• Two standard patch-panel trays

• Sixteen fiber-optic MPO cables: each MPO cable is terminated on one 
end with one MPO connector and on the other end with eight LC-type 
connectors

ROADM node:

• Two 32WSS cards

• Two 32DMX cards

• Two standard patch-panel trays

• Sixteen fiber-optic MPO cables: each MPO cable is terminated on one 
end with one MPO connector and on the other end with eight LC-type 
connectors

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-66

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 2 On the patch panel, pull up firmly on the two latches and use them to slide the patch panel up until it 
snaps in place above the tray (Figure 3-14).

Figure 3-14 Using the Patch-Panel Latches to Slide the Patch Panel Away from the Tray

Step 3 At the 32WSS or 32MUX-O card in the node, plug the MPO connector of an MPO cable (Figure 3-15) 
into the top Add RX (30.3–36.6) port of the card. If you are connecting a subsequent MPO cable, plug 
the MPO connector into the first vacant Add RX card port below the last MPO cable that was installed.
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Figure 3-15 MPO Cable
.

Step 4 Route the MPO cable slack through the patch-panel tray as necessary.

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure that adequate cable slack remains.

Step 5 While facing the front of the patch panel, at the rear side of the patch panel, plug the eight LC-connector 
fan-out cables on the MPO cable into their corresponding connectors on the bottom row of the patch 
panel. You should plug the fan-out cables from left to right (as you face the patch panel), following the 
numbers tagged (1 through 8) on the cables. 

Figure 3-16 shows the patch-panel connectors from the rear of the patch-panel tray. Figure 3-17 shows 
the assigned wavelengths for each port on the patch panel, as indicated at the top of the patch-panel bar. 
The numbers on the patch-panel bar correspond to a wavelength on the ITU grid.
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Figure 3-16 Rear View of the Patch Panel
.

Figure 3-17 Top View of the Patch-Panel Bar

Step 6 As necessary, repeat Steps 3 through 5 for the remaining three Add RX ports on the 32WSS or 
32MUX-O card, until all 32 LC connectors on the bottom row of the rear of the patch panel are 
connected. 

Step 7 At the adjacent 32DMX or 32DMX-O card in the same side of the shelf, plug the MPO connector of an 
MPO cable into the top Drop TX (30.3–36.6) port of the 32DMX or 32DMX-O card. If you are 
connecting a subsequent MPO cable, plug the MPO connector into the first vacant Drop TX card port 
below the last MPO cable that was installed.

Step 8 Route the MPO cable slack through the patch-panel tray as necessary.

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure that adequate cable slack remains.

Step 9 While facing the front of the patch panel, at the rear of the patch panel, plug the eight LC-connector 
fan-out cables on the MPO cable into their corresponding connectors on the top row of the patch panel. 
You should plug the fan-out cables from left to right (as you face the patch panel), following the numbers 
tagged (1 through 8) on the cables.

Step 10 As necessary, repeat Steps 7 through 9 for the remaining three Drop TX ports on the 32DMX or DMX-O 
card, until all 32 LC connectors on the top row of the rear of the patch panel are connected.

Step 11 For a hub or ROADM node, repeat Steps 2 through 10 to cable the other side of the shelf to the second 
patch panel. For a terminal node, go to Step 12.

Step 12 Return to your originating procedure (NTP).
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DLP-G316 Install Fiber-Optic Cables from TXP, MXP, GE_XP, 10GE_XP, or 
ADM-10G Cards to the Standard Patch-Panel Tray

Step 1 At the appropriate TXP, MXP, GE_XP, 10GE_XP, or ADM-10G card, plug one end of a fiber-optic cable 
into the TX port of the DWDM adapter.

Step 2 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray.

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 3 On the DWDM (front) side of the patch panel, plug the other end of the cable into the connector on the 
bottom row that corresponds to the wavelength to which the TXP, MXP, GE_XP, 10GE_XP, or 
ADM-10G port is tuned. (See Figure 3-17 on page 3-77 for a view of the wavelengths assigned to the 
patch-panel connectors). 

Figure 3-18 shows the patch-panel connectors from the front of the patch-panel tray. 

Figure 3-18 Front View of the Patch Panel
.

Step 4 Plug one end of a fiber-optic cable into the RX port of the DWDM adapter on the TXP, MXP, GE_XP, 
10GE_XP, or ADM-10G card.

Step 5 On the DWDM (front) side of the patch panel, plug the other end of the cable into the connector on the 
top row that corresponds to the wavelength to which the TXP, MXP, GE_XP, 10GE_XP, or ADM-10G 
is tuned.

Purpose This task describes how to route fiber-optic cables from the patch panel to 
TXP, MXP, GE_XP, 10GE_XP, or ADM-10G cards.

Tools/Equipment TXP, MXP, GE_XP, 10GE_XP, or ADM-10G card(s)

Fiber-optic cable(s)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-66

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 6 Repeat Steps 1 through 5 for all of the TXP, MXP, GE_XP, 10GE_XP, or ADM-10G cards that you want 
to connect to this patch panel.

Step 7 Return to your originating procedure (NTP).

.

DLP-G356 Install Fiber-Optic Cables from the 32WSS/32DMX and 
32MUX-O/32DMX-O Cards to the Deep Patch-Panel Tray

Purpose This task describes how to route fiber-optic cables from 32MUX-O, 
32WSS, 32DMX-O, and 32DMX cards in a terminal, hub, or ROADM node 
to the deep patch-panel tray.

Tools/Equipment The following node types require the following equipment. The cards and 
patch panels should already be installed before you begin this procedure.

For terminal nodes, one of the following card sets:

• One 32MUX-O card and one 32DMX-O or 32DMX card

• One 32WSS card and one 32DMX or 32DMX-O card

• One 32WSS-L cards and one 32DMX-L card

Plus one deep patch-panel tray, preinstalled with MPO cables (each MPO 
cable is terminated on one end with one MPO connector and on the other 
end with eight LC-type connectors)

For hub nodes, one of the following card sets:

• Two 32MUX-O cards and two 32DMX-O or 32DMX cards

• Two 32WSS cards and two 32DMX or 32DMX-O cards

• Two 32WSS-L cards and two 32DMX-L cards

Plus two deep patch-panel trays, preinstalled with MPO cables (each MPO 
cable is terminated on one end with one MPO connector and on the other 
end with eight LC-type connectors)

For ROADM nodes, one of the following card sets:

• Two 32WSS cards and two 32DMX or 32DMX-O cards

• Two 32WSS-L cards and two 32DMX-L cards

Plus two deep patch-panel trays, preinstalled with MPO cables (each MPO 
cable is terminated on one end with one MPO connector and on the other 
end with eight LC-type connectors)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-66

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note For a ROADM or hub node, two patch panels will be used, one for Side A (Slots 1 through 6) and one 
for Side B (Slots 12 through 17). The Side B 32WSS/32DMX card will connect to the Side B patch panel. 
The Side A 32WSS/32DMX card will connect to the Side A patch panel. The MPO cables in the patch 
panel are preinstalled and routed out of the right side of the patch-panel tray.

Step 1 Choose either Side A or Side B of the shelf to cable the 32MUX-O and 32DMX-O cards (or the 32WSS 
and 32DMX cards for a ROADM node).

Step 2 On the patch panel, locate the MPO connectors (Figure 3-15 on page 3-76).

Step 3 Route the preinstalled MPO cables out of the tray to the right or left (Figure 3-19).

Figure 3-19 Deep Patch-Panel Tray

Step 4 At the 32WSS or 32MUX-O card in the node, plug the MPO connector labeled 1 RX on an MPO cable 
(Figure 3-15 on page 3-76) into the top Add RX (30.3–36.6) port of the card. 

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure that adequate cable slack remains.

Step 5 Plug the MPO connector labeled 2-RX into the Add RX (38.1–44.5) port on the card. 

Step 6 Plug the MPO connector labeled 3-RX into the Add RX (46.1–52.5) port on the card. 

Step 7 Plug the MPO connector labeled 4-RX into the Add RX (54.1–60.6) port on the card. 

Figure 3-20 shows the deep patch-panel ports and corresponding wavelengths.

14
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Figure 3-20 Deep Patch-Panel Port Wavelengths

Step 8 At the adjacent 32DMX or 32DMX-O card in the same side of the shelf, plug the MPO connector labeled 
1 TX on the MPO cable (Figure 3-15 on page 3-76) into the top Drop TX (30.3–36.6) port of the card 
(Figure 3-20). 

Step 9 Plug the MPO connector labeled 2-TX into the Drop TX (38.1–44.5) port on the card. 

Step 10 Plug the MPO connector labeled 3-TX into the Drop TX (46.1–52.5) port on the card. 

Step 11 Plug the MPO connector labeled 4-TX into the Drop TX (54.1–60.6) port on the card. 

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure that adequate cable slack remains.

Step 12 For a hub or ROADM node, repeat Steps 2 through 11 to cable the other side of the shelf to the second 
patch panel. For a terminal node, go to Step 13.

Step 13 Return to your originating procedure (NTP).
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DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch-Panel Tray

Step 1 Carefully unwind all of the MPO cables in the patch-panel tray and gently set the cables to the side of 
the tray, out of the way of the internal hardware.

Figure 3-21 and Figure 3-22 show the 40-channel patch-panel tray.

Figure 3-21 40-Channel Patch-Panel Tray, Side View

Purpose This task reroutes the MPO cables that are preinstalled in the 40-channel 
patch-panel tray. The cables exit to the left when shipped; this task reroutes 
the cables out of the right side of the tray. Use this task when you want to 
connect these MPO cables to cards installed on the right side of the shelf 
(Slots 12 through 17).

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 3-22 40-Channel Patch-Panel Tray, Top View

Step 2 Slide each of the ten LC-port adapter packs upward.

Step 3 Unscrew the two screws in the bottom left bending limiter and remove the bending limiter.

Step 4 Remove the single screw below the center of the patch panel to free the patch panel hardware.

Step 5 Slide the patch panel to the left, and reinstall the screw below the center of the patch panel.

Step 6 Install the bending limiter to the right of the patch panel by installing the two screws.

Step 7 Carefully route all of the MPO cables around the bending limiter and out the exit on the right side of the 
patch-panel tray.

Step 8 Slide each of the ten LC-port adapter packs downward.

Step 9 Return to your originating procedure (NTP).
15

98
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DLP-G428 Install Fiber-Optic Cables from the 40-WSS-C/40-WSS-CE and 
40-DMX-C/40-DMX-CE Cards in an Expanded ROADM, Terminal, or Hub Node to 
the 40-Channel Patch-Panel Tray

Note For a ROADM node, two patch panels will be used, one for the Side A (Slots 1 through 6) and one for 
Side B (Slots 12 through 17). The Side B 40-WSS-C/40-WSS-CE card will connect to the Side B patch 
panel. The Side A 40-WSS-C/40-WSS-CE will connect to the Side A patch panel. The MPO cables in 
the patch panel are preinstalled and routed out of the left side of the patch-panel tray.

Step 1 Choose either the Side A or Side B side of the shelf to cable the 40-WSS-C/40-WSS-CE and 
40-DMX-C/40-DMX-CE cards.

Note If you are cabling cards on Side B of the shelf, you must first perform the “DLP-G427 Reroute 
Fiber-Optic Cables in the 40-Channel Patch-Panel Tray” task on page 3-82 to route the MPO 
cables out of the right side of the patch-panel tray, or route the cables through a fiber storage 
panel.

Purpose This task describes how to route fiber-optic cables from 
40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards in an 
expanded ROADM, terminal, or hub node to the 40-channel (80-port) 
patch-panel tray (15454-PP-80).

Tools/Equipment The following node types require the following equipment. The cards and 
patch panels should already be installed before you begin this procedure.

Expanded terminal nodes:

• One 40-WSS-C or 40-WSS-CE card

• One 40-DMX-C or 40-DMX-CE card

Plus one 40-channel patch-panel tray, preinstalled with MPO cables (each 
MPO cable is terminated on one end with one MPO connector and on the 
other end with eight LC-type connectors)

Expanded hub or ROADM nodes:

• Two 40-WSS-C or 40-WSS-CE cards

• Two 40-DMX-C or 40-DMX-CE cards

Plus two 40-channel patch-panel trays, preinstalled with MPO cables (each 
MPO cable is terminated on one end with one MPO connector and on the 
other end with eight LC-type connectors)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-66

DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch-Panel 
Tray, page 3-82

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 2 On the patch panel, locate the MPO cables and connectors.

Step 3 At the 40-WSS-C/40-WSS-CE card in the node, plug the MPO connector labeled 1 RX on an MPO cable 
(Figure 3-15 on page 3-76) into the top Add RX (30.3–35.8) port of the card. 

Step 4 Plug the MPO connector labeled 2-RX into the Add RX (36.6–42.1) port on the card.

Step 5 Plug the MPO connector labeled 3-RX into the Add RX (42.9–48.5) port on the card.

Step 6 Plug the MPO connector labeled 4-RX into the Add RX (49.3–54.9) port on the card.

Step 7 Plug the MPO connector labeled 5-RX into the Add RX (55.7–61.4) port on the card.

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure that adequate cable slack remains.

Figure 3-23 shows the 40-channel patch-panel ports and corresponding wavelengths.

Figure 3-23 40-Channel (15454-PP-80) Patch-Panel Port Wavelengths

Step 8 At the adjacent 40-DMX-C/40-DMX-CE card in the same side of the shelf, plug the MPO connector 
labeled 1 TX on the MPO cable into the top Drop TX (30.3–35.8) port of the card. 

Step 9 Plug the MPO connector labeled 2-TX into the Drop TX (36.6–42.1) port on the card.

Step 10 Plug the MPO connector labeled 3-TX into the Drop TX (42.9–48.5) port on the card.

Step 11 Plug the MPO connector labeled 4-TX into the Drop TX (49.3–54.9) port on the card.

Step 12 Plug the MPO connector labeled 5-TX into the Drop TX (55.7–61.4) port on the card.

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure that adequate cable slack remains.
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Step 13 Repeat Steps 2 through 12 to cable the other side of the shelf to the second patch panel. 

Step 14 Return to your originating procedure (NTP).

DLP-G357 Install Fiber-Optic Cables from the TXP, MXP, GE_XP, 10GE_XP, or 
ADM-10G Cards to the Deep Patch-Panel Tray or 40-Channel Patch-Panel Tray

Step 1 Refer to the Cisco TransportPlanner Internal Connections Report to connect the TXP, MXP, GE_XP, 
10GE_XP, or ADM-10G card to the proper (Side A or Side B) patch panel. Cisco TransportPlanner 
designates Side A as Slots 1 to 6 and Side B as Slots 12 to 17. At the appropriate TXP, MXP, GE_XP, 
10GE_XP, or ADM-10G card, plug one end of a fiber-optic cable into the TX port of the DWDM adapter. 

Step 2 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray.

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 3 Plug the other end of the cable into the RX connector on the patch panel that corresponds to the 
wavelength to which the TXP, MXP, GE_XP, 10GE_XP or ADM-10G port is tuned. (See Figure 3-20 on 
page 3-81 for a view of the wavelengths assigned to the deep patch-panel connectors or Figure 3-23 on 
page 3-85 for a view of the wavelengths assigned to the 40-channel patch-panel connectors). 

Step 4 On the patch-panel tray, slide each of the ten LC-port adapter packs upward.

Step 5 Plug one end of a fiber-optic cable into the RX port of the DWDM adapter on the TXP, MXP, GE_XP, 
10GE_XP, or ADM-10G card.

Step 6 Plug the other end of the cable into the TX connector on the patch panel that corresponds to the 
wavelength to which the TXP, MXP, GE_XP, 10GE_XP, or ADM-10G port is tuned.

Step 7 Repeat Steps 1 through 6 for each TXP, MXP, GE_XP, 10GE_XP, or ADM-10G card that you want to 
connect to this patch panel.

Purpose This task describes how to route fiber-optic cables from the deep patch 
panel (32-channel) or 40-channel patch panel to TXP, MXP, GE_XP, 
10GE_XP, or ADM-10G cards.

Tools/Equipment TXP, MXP, GE_XP, 10GE_XP, or ADM-10G card(s)

Deep (32-channel) patch panel tray or 40-channel patch panel tray

Fiber-optic cable(s)

Cisco TransportPlanner Internal Connections Report

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-66

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 8 Return to your originating procedure (NTP).

NTP-G185 Install Fiber-Optic Cables between Mesh Nodes

Step 1 Open the patch-panel tray:

• 40-channel patch-panel tray: On the front of the patch-panel tray, push the tabs on the left and right 
sides inward to release the lock on the tray. Pull the patch-panel tray away from the shelf until it is 
fully opened.

• Mesh patch-panel tray: On the front of the patch-panel tray, push the tabs on the left and right sides 
inward to open the front door. Raise the plunger located to the right of the TEST ACCESS Tx port 
and pull the tray toward away from the rack.

Step 2 Complete the “DLP-G430 Install Fiber-Optic Cables from the 40-MUX-C and 40-DMX-C Cards in a 
Mesh Node to the 40-Channel Patch-Panel Tray” task on page 3-88.

Step 3 Complete the “DLP-G431 Install Fiber-Optic Cables from the 40-WXC-C Cards in a Mesh Node to a 
Mesh Patch-Panel Tray” task on page 3-90.

Step 4 Close the patch-panel tray:

• 40-channel patch-panel tray: Push the tray back toward the rack until it locks into place. 

Purpose This procedure describes how to install fiber-optic cables to create mesh 
nodes. You must route fiber-optic cables from 40-MUX-C and 40-DMX-C 
cards in a mesh node to the 40-channel (80-port) patch-panel tray 
(15454-PP-80), and from the 40-WXC-C cards in a mesh node to one of the 
mesh patch-panel trays (four-degree or eight-degree).

Tools/Equipment Mesh nodes require the following equipment. The cards and patch panels 
should already be installed before you begin this procedure.

One 40-MUX-C card per side of the mesh node (up to 8 sides per node)

One 40-DMX-C card per side of the mesh node (up to 8 sides per node)

One 40-channel patch-panel tray per side of the mesh node (up to 8 sides 
per node) 

One 40-WXC-C card per side (up to 8 sides per node)

One MPO-MPO fiber-optic cable per side (up to 8 sides per node)

One LC-LC fiber-optic cable per side (up to 8 sides per node)

One four-degree (PP-MESH-4) or eight-degree (PP-MESH-8) mesh 
patch-panel tray, depending on the type of mesh node you want to install

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-66

DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch-Panel 
Tray, page 3-82

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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• Mesh patch-panel tray: Raise the plunger located on the right of the TEST ACCESS Tx port and 
push the tray until the plunger locks into the closed position.

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the tray, make sure that adequate cable slack remains.

Stop. You have completed this procedure.

DLP-G430 Install Fiber-Optic Cables from the 40-MUX-C and 40-DMX-C Cards in 
a Mesh Node to the 40-Channel Patch-Panel Tray

Step 1 Choose Side A of the shelf to cable the 40-MUX-C and 40-DMX-C cards.

Note If you are cabling any cards from the right side of the shelf (Slots 12 through 17), you must first 
perform the “DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch-Panel Tray” task 
on page 3-82 to route the MPO cables out of the right side of the patch-panel tray, or route the 
cables through a fiber storage panel.

Step 2 On the patch panel, locate the MPO cables and connectors.

Purpose This task describes how to route fiber-optic cables from 40-MUX-C and 
40-DMX-C cards in mesh node to the 40-channel (80-port) patch-panel tray 
(15454-PP-80). In a mesh node, one 40-channel patch panel tray is required 
for each direction. The Side A 40-MUX-C and 40-DMX-C cards will 
connect to the Side A 40-channel patch panel. The Side B 40-MUX-C and 
40-DMX-C cards will connect to the Side B 40-channel patch panel, and so 
forth, up to a maximum of an eight-degree mesh node (Sides A through H). 

Tools/Equipment The cards and patch panels should already be installed before you begin 
this procedure.

One 40-MUX-C card per side of the mesh node

One 40-DMX-C card per side of the mesh node

One 40-channel patch-panel trays per side of the mesh node, preinstalled 
with MPO cables (each MPO cable is terminated on one end with one MPO 
connector and on the other end with eight LC-type connectors)

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-66

DLP-G427 Reroute Fiber-Optic Cables in the 40-Channel Patch-Panel 
Tray, page 3-82

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 3 At the 40-MUX-C card in the node, plug the MPO connector labeled 1 RX on an MPO cable into the top 
Add RX (30.3–35.8) port of the card. 

Step 4 Plug the MPO connector labeled 2-RX into the Add RX (36.6–42.1) port on the card. 

Step 5 Plug the MPO connector labeled 3-RX into the Add RX (42.9–48.5) port on the card. 

Step 6 Plug the MPO connector labeled 4-RX into the Add RX (49.3–54.9) port on the card. 

Step 7 Plug the MPO connector labeled 5-RX into the Add RX (55.7–61.4) port on the card. 

Step 8 At the adjacent 40-DMX-C card in the same side of the shelf, plug the MPO connector labeled 1 TX on 
the MPO cable. 

Step 9 Plug the MPO connector labeled 2-TX into the Drop TX (36.6–42.1) port on the card. 

Step 10 Plug the MPO connector labeled 3-TX into the Drop TX (42.9–48.5) port on the card. 

Step 11 Plug the MPO connector labeled 4-TX into the Drop TX (49.3–54.9) port on the card. 

Step 12 Plug the MPO connector labeled 5-TX into the Drop TX (55.7–61.4) port on the card. 

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure that adequate cable slack remains.

Step 13 Repeat Steps 2 through 12 for the remaining sides of the mesh node (Sides B through H, depending on 
the type of mesh node you want to cable).

Step 14 Return to your originating procedure (NTP).
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DLP-G431 Install Fiber-Optic Cables from the 40-WXC-C Cards in a Mesh Node 
to a Mesh Patch-Panel Tray

Step 1 Choose Side A of the shelf to cable the 40-WXC-C card to the mesh patch panel.

Step 2 On the mesh patch panel, locate the EXP TX A port and insert one end of an MPO-MPO cable.

Step 3 Route the MPO cable through the mesh patch panel and out to the 40-WXC-C card on Side A of the node.

Step 4 Connect the other end of the MPO cable to the EXP RX port on the 40-WXC-C.

Step 5 On the mesh patch panel, locate the COM RX A port and insert one end of an LC-LC cable.

Step 6 Route the LC cable through the mesh patch panel to the 40-WXC-C card on Side A of the node.

Step 7 Connect the other end of the LC cable to the EXP TX port on the 40-WXC-C.

Step 8 Repeat Steps 1 through 7 as necessary to cable Sides B through D for a 4-degree patch panel, and Sides B 
through H for an 8-degree patch panel.

Caution When you close the patch-panel tray, the cables must not be pinched, and the cable bend radius must be 
equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the patch-panel tray, make sure that adequate cable slack remains.

Stop. You have completed this procedure.

Purpose This task connects fiber-optic cables from the 40-WXC-C cards in a mesh 
node to the 4-degree or 8-degree mesh patch panel. The four-degree patch 
panel allows up to 4 sides to be used per node, while the eight-degree patch 
panel allows up to 8 sides to be used per node.

Tools/Equipment The cards and patch panel trays should already be installed before you 
begin this procedure.

One 40-WXC-C card per side (up to 8 sides per node)

One MPO-MPO fiber-optic cable per side

One LC-LC fiber-optic cable per side

One four-degree or eight-degree mesh patch-panel tray

Cisco TransportPlanner Internal Connections Report

Prerequisite Procedures DLP-G28 Install the Fiber Patch-Panel Tray, page 1-70

DLP-G29 Install the Fiber-Storage Tray, page 1-70

NTP-G34 Install Fiber-Optic Cables on DWDM Cards and DCUs, page 
3-66

DLP-G348 Use the Cisco TransportPlanner Shelf Layout Report, page 3-57

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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NTP-G191 Install Fiber-Optic Cables on Passthrough ROADM 
Nodes

Step 1 Choose either the East or West side of the first shelf to cable the 32WSS card for the first ROADM node.

Step 2 Choose the corresponding West or East side of the second shelf to cable the 32WSS card for the second 
ROADM node.

Step 3 On the front of the fiber-storage tray that will be used for routing the fiber-optic cable, push the tabs on 
the left and right sides inward to release the lock on the tray. 

Step 4 Pull the fiber-storage tray away from the shelf until it is fully opened.

Step 5 Open the fold-down door located at the bottom of both shelf assemblies to expose the cable-routing 
channels for each (Figure 3-24).

Purpose This procedure routes fiber-optic cables from a 32WSS card in a ROADM 
node in one shelf to the corresponding 32WSS card in a ROADM node in 
another shelf. The purpose of this routing is to connect East and West 
intershelf ROADMs in a passthrough configuration.

Tools/Equipment Each ROADM node requires the listed equipment. The cards and 
fiber-storage trays should already be installed before you begin this 
procedure.

• One 32WSS card 

• One fiber-storage tray

• Two 3-meter fiber-optic cables, each terminated with a single LC 
connector on each end.

• Cisco TransportPlanner Internal Connections Report

Prerequisite Procedures DLP-G29 Install the Fiber-Storage Tray, page 1-70

DLP-G348 Use the Cisco TransportPlanner Shelf Layout Report, page 3-57

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 3-24 Managing Cables on the Front Panel 

Step 6 Plug one end of the first 3-meter fiber-optic cable into the EXP-TX connector on the first 32WSS card.

Step 7 Route the fiber-optic cable through the shelf cable-routing channel and cutout on the appropriate side of 
the shelf assembly, as necessary.

Step 8 Route the fiber-optic cable through the vertical fiber guide as needed to reach the entry to the 
fiber-storage tray.

Step 9 Thread the cable into the fiber-storage tray at the appropriate side and around the first bend radius 
delimiter as shown (Figure 3-25).

Step 10 As needed, route slack fiber-optic cable around the slack management cable retainers in the fiber-storage 
tray (Figure 3-25).

Figure 3-25 Fiber-Storage Tray

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.
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Step 11 Thread the fiber cable through the second bend delimiter and out the appropriate side of the fiber-storage 
tray as necessary. 

Step 12 Route the fiber-optic cable through the vertical fiber guide as needed to reach the second ROADM shelf 
where the second 32WSS is located.

Step 13 Route the fiber-optic cable through the shelf cutout and through the shelf cable routing channel as 
needed.

Step 14 Plug the end of the 3-meter fiber-optic cable into the EXP-RX port of the second 32WSS card. 

Step 15 Plug one end of the second 3-meter fiber-optic cable into the EXP-TX connector on the second 32WSS 
card.

Step 16 Follow Step 7 through Step 14 to connect the EXP-TX connector of the second 32WSS card to the 
EXP-RX port of the first 32WSS card.

Step 17 Close the fold-down doors located at the bottom of both shelf assemblies and slide the fiber-storage tray 
back into its normal locked position.

Stop. You have completed this procedure.

NTP-G141 Install Fiber-Optic Cables for Y-Cable Protection 
Modules

Note Refer to the “Shelf Assembly Hardware” and “Transponder and Muxponder Cards” chapters in the 
Cisco ONS 15454 DWDM Reference Manual for more information about Y-cable protection.

Purpose This procedure installs and routes fiber-optic cables from the client signal 
to the Y-cable protection module (single mode or multimode), and from the 
Y-cable module to the transponder node. Using one Y-cable protection 
module, you can protect one client signal with two TXP, MXP, GE_XP, or 
10GE_XP cards, and two client signals with four TXP, MXP, GE_XP, or 
10GE_XP cards. You can use Y-cable protection modules that you have 
installed in a FleyLayer shelf, or Y-cable modules installed in a Y-cable 
module tray.

Tools/Equipment Fiber-optic cables

Cisco TransportPlanner Internal Connections Report

Prerequisite Procedures DLP-G32 Install the Y-Cable Protection Modules in the FlexLayer Shelf, 
page 1-75

DLP-G377 Install the Y-Cable Protection Modules in the Y-Cable Module 
Tray, page 1-75

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
3-93
Cisco ONS 15454 DWDM Procedure Guide, R8.5

78-18108-02



 

Chapter 3      Turn Up a Node
DLP-  G375 Install Fiber-Optic Cables on the Y-Cable Modules in the FlexLayer Shelf
Note To use Y-cable protection for GE_XP and 10GE_XP cards, the cards must be provisioned in 10GE MXP, 
20GE MXP, or 10GE TXP mode. (See the “DLP-G379 Change the GE_XP or 10GE_XP Card Mode” 
task on page 5-7.) Y-cable protection cannot be used for GE_XP and 10GE_XP cards that are 
provisioned in L2 over DWDM mode. 

Step 1 As needed, complete the “DLP-G375 Install Fiber-Optic Cables on the Y-Cable Modules in the 
FlexLayer Shelf” task on page 3-94.

Step 2 As needed, complete the “DLP-G376 Install Fiber-Optic Cables on the Y-Cable Modules in the Y-Cable 
Module Tray” task on page 3-96.

Stop. You have completed this procedure.

DLP-G375 Install Fiber-Optic Cables on the Y-Cable Modules in the FlexLayer 
Shelf

Step 1 Referring to the Cisco TransportPlanner Internal Connections Report, install a fiber-optic cable between 
a TXP, MXP, GE_XP, or 10GE_XP card and a Y-cable module.

If you want to protect one client signal, connect the fiber-optic cables according to either Table 3-6 or 
Table 3-7. To protect two client signals using a single Y-cable module, connect the cables according to 
both Table 3-6 and Table 3-7.

Purpose This task installs fiber-optic cables from the TXP, MXP, GE_XP, or 
10GE_XP cards to the Y-cable modules installed in the FlexLayer shelves, 
and from the Y-cable modules to the client devices.

Tools/Equipment Fiber-optic cables

Cisco TransportPlanner Internal Connections Report

Prerequisite Procedures DLP-G32 Install the Y-Cable Protection Modules in the FlexLayer Shelf, 
page 1-75

NTP-G179 Install the TXP, MXP, GE_XP, 10GE_XP, and ADM-10G 
Cards, page 3-59

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 3-6 Cable Connections for Y-Cable Protection of One Client Signal

From To (Y-Cable Port Number)

Client 1 TX port 10

Client 1 RX port 5

TXP/MXP/GE_XP/10GE_XP 1 TX port 1

TXP/MXP/GE_XP/10GE_XP 1 RX port 2
3-94
Cisco ONS 15454 DWDM Procedure Guide, R8.5

78-18108-02



 

Chapter 3      Turn Up a Node
DLP-  G375 Install Fiber-Optic Cables on the Y-Cable Modules in the FlexLayer Shelf
Step 2 As needed, route slack fiber-optic cable around the round cable retainers in the fiber-storage tray as you 
install cables between the Y-cable module and the TXP, MXP, GE_XP, or 10GE_XP cards (Figure 3-11 
on page 3-67). 

Caution When you close the fiber-storage tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the fiber-storage tray, make sure that adequate cable slack remains.

Step 3 Install a fiber-optic cable between the client device and the Y-cable module where you just installed a 
fiber-optic cable to the TXP, MXP, GE_XP, or 10GE_XP card. 

Step 4 Repeat Steps 1 through 3 for each Y-cable module you need to use for Y-cable protection.

Step 5 Return to your originating procedure (NTP).

TXP/MXP/GE_XP/10GE_XP 2TX port 6

TXP/MXP/GE_XP/10GE_XP 2RX port 7

Table 3-7 Cable Connections for Y-Cable Protection of a Second Client Signal

From To (Y-Cable Port Number)

Client 2 TX port 12

Client 2 RX port 11

TXP/MXP/GE_XP/10GE_XP 3 TX port 3

TXP/MXP/GE_XP/10GE_XP 3 RX port 4

TXP/MXP/GE_XP/10GE_XP 4 TX port 8

TXP/MXP/GE_XP/10GE_XP 4 RX port 9

Table 3-6 Cable Connections for Y-Cable Protection of One Client Signal (continued)

From To (Y-Cable Port Number)
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DLP-G376 Install Fiber-Optic Cables on the Y-Cable Modules in the Y-Cable 
Module Tray

Step 1 Open the drawer of the tray by pushing inward on the latches located at the left and right front of the tray.

Step 2 On each Y-cable module you will connect, use the tab to slide the module up so that it is fully extended 
and easily accessible in the tray.

Step 3 Referring to the Cisco TransportPlanner Internal Connections Report, install a 4-meter (13.12-foot) 
fiber-optic cable (single-mode or multimode, as appropriate) between a TXP, MXP, GE_XP, or 
10GE_XP card and the Y-cable module installed farthest to the left. Proceed according to the port label 
affixed to the front of the tray to identify the ports on each installed module (Figure 3-26). 

Figure 3-26 Y-Cable Protection Port Label

Purpose This task installs fiber-optic cables from the TXP, MXP, GE_XP, or 
10GE_XP cards to the Y-cable modules installed in the Y-cable module 
tray, and from the Y-cable modules to the client devices.

Tools/Equipment Fiber-optic cables (4-meter [13.12-foot]), single-mode or multimode as 
appropriate

Cisco TransportPlanner Internal Connections Report

Prerequisite Procedures DLP-G32 Install the Y-Cable Protection Modules in the FlexLayer Shelf, 
page 1-75

NTP-G179 Install the TXP, MXP, GE_XP, 10GE_XP, and ADM-10G 
Cards, page 3-59

Required/As Needed As needed

Onsite/Remote Onsite 

Security Level None

Client TX

Client RX

TXP W TX

TXP W RX TXP W RX TXP W RX TXP W RXTXP W RX TXP W RX TXP W RX TXP W RX

TXP P RX
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TXP P RX TXP P RX TXP P RX TXP P RX TXP P RX TXP P RX TXP P RX

TXP W TX TXP W TX TXP W TX TXP W TX TXP W TX TXP W TX TXP W TX

Client RX Client RX Client RX Client RX Client RX Client RX Client RX

Client TX Client TX Client TX Client TX Client TX Client TX Client TX

#1 #2 #3 #4 #5 #6 #7 #8
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Note You can use the label shown in Figure 3-26 to take notes as to which wavelength/port you are 
connecting to each Y-cable module. “W” denotes the indicated Working port on the TXP, MXP, 
GE_XP, or 10GE_XP card. “P” denotes the indicated Protect port on the TXP, MXP, GE_XP, or 
10GE_XP card. 

Note Protective covers are installed over the third and fourth ports on the Y-cable modules because 
they are not used.

As needed, route slack fiber-optic cable around the round cable retainers in theY-cable module tray as 
you install cables between the Y-cable module and the TXP, MXP, GE_XP, or 10GE_XP card 
(Figure 3-27). 

Figure 3-27 Y-Cable Protection Module Tray

Caution When you close the Y-cable module tray, the cables must not be pinched, and the cable bend radius must 
be equal to or greater than the minimum radius that is recommended in your site specifications. As you 
route each cable through the tray, make sure that adequate cable slack remains.

Step 4 Referring to the Cisco TransportPlanner Internal Connections Report, install a fiber-optic cable of 
adequate length (single-mode or multimode, as appropriate) between the Y-cable module and the client 
signal that you want to protect. 

Step 5 As needed, route slack fiber-optic cable around the round cable retainers in theY-cable module tray as 
you install cables between the Y-cable module and the TXP, MXP, GE_XP, or 10GE_XP card.

Step 6 Repeat Steps 2 through 5 for each Y-cable module you need to use for Y-cable protection.

14
46

78
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Step 7 To close the tray, unlock the drawer from the open position by depressing the red lock at the back left of 
the tray and push the tray closed.

Step 8 Return to your originating procedure (NTP).

NTP-G152 Create and Verify Internal Patchcords

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to provision the 
DWDM cable connections. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcords tabs.

Step 3 Click Default Patchcords. 

CTC verifies that the cards installed in the ONS 15454 shelf are compatible and will operate together as 
a valid DWDM node configuration. Furthermore, based on the cards installed or preprovisioned, CTC 
calculates the intra-shelf patchcords that are expected to be installed.

Note The Internal Patchcords tab does not show OPT-PRE DCU connections or span connections.

Note The connections calculation is not based on the Cisco TransportPlanner shelf layout or Internal 
Connections report. Calculations are based on the cards that are physically installed. If the 
Cisco TransportPlanner shelf layout calls for a hub node but OADM cards are installed, CTC 
calculates connections based on the cards expected for an OADM node.

Note The number of rows in the Maintenance > DWDM > Mesh Patch Panel Internal Patchcords 
tab are created dynamically, as per the number of sides present in a node.

Step 4 If no errors were generated, continue with Step 5. If errors appear, verify that the cards installed in the 
shelf match the Cisco TransportPlanner shelf layout. If the wrong cards are installed or are missing, 
install the correct cards following the “NTP-G30 Install the DWDM Cards” procedure on page 3-54. 

Purpose This procedure creates the default internal patchcords, verifies the installed 
cards, and calculates the connections that should be provisioned for them.

Tools/Equipment Cisco TransportPlanner shelf layout

Cisco TransportPlanner Internal Connections Report

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 5 Verify that the connections in the Internal Patchcords tab match the connections in the Cisco 
TransportPlanner Internal Connections Report for the DWDM cards (see the “DLP-G349 Use the Cisco 
TransportPlanner Internal Connections Report” task on page 3-68). The Internal Patchcords tab will not 
show OPT-PRE DCU connections or span connections.

Step 6 Complete the “DLP-G354 Create an Internal Patchcord Manually” task on page 3-99 for any 
connections that require manual provisioning, for example, to create patchcords between TXP and MXP 
trunk ports and OCH filter ports. If you need to delete a connection, complete the “DLP-G355 Delete an 
Internal Patchcord” task on page 3-102.

Note Although CTC calculates most DWDM connections automatically, some connections cannot be 
calculated because of the DWDM card type and position. You must create these connections 
manually. For example, connections related to optical bypass circuits must be manually 
provisioned. 

Stop. You have completed this procedure.

DLP-G354 Create an Internal Patchcord Manually

Note Use only one management interface to complete the creation of internal patchcords. For example, do not 
begin the internal patchcord creation using the TL1 interface or CTP XML file and end the internal 
patchcord creation using CTC.

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcord tabs.

Step 2 Click Create.

Step 3 Choose one of the following link types for the internal patchcord. See Table 3-8 for a list of ports that 
are available for each option. 

• OCH-Trunk to OCH-FILTER—Creates an internal patchcord between an optical channel trunk port 
on a TXP, MXP, GE_XP, 10GE_XP, ADM-10G, or ITU-T line card and an optical channel filter port 
on a 32MUX, 40-MUX-C, 32WSS, or 40-WSS-C/40-WSS-CE card.

• OTS/OCH to OTS/OCH—Creates an internal patchcord between two optical transport section 
(OTS) ports. 

Purpose This task creates an internal patchcord manually when CTC is unable to 
calculate the internal patchcords automatically. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Note Manual creation of OTS/OCH to OTS/OCH internal patchcords should never be needed for 
standard DWDM nodes. Manual creation might be needed for non-standard nodes, for example, 
a hub node that has wavelength selective switches installed. Manual creation will be 
recommended by Cisco TransportPlanner.

The remaining fields on the page depend on the patchcord type selected.

• OCHNC Wavelength (OCH-Trunk to OCH-FILTER only)—Sets the OCHNC wavelength for the 
OCH trunk to OCH filter internal patchcord. Use the unnamed band selection box below to display 
C-band or L band wavelengths in the OCHNC Wavelength field. Provision the OCHNC wavelength 
to the wavelength provisioned for the TXP, MXP, GE_XP, 10GE_XP, ADM-10G, or ITU-T line card 
trunk port.

• Bidirectional (OTS/OCH to OTS/OCH only)—If selected, creates a bidirectional OTS/OCH to 
OTS/OCH internal patchcord.

Note To successfully create an Internal Patchcord between WSS/DMX channel port and TxP 
trunk port, the TxP must be choosen as "From" end point while WSS/DMX must be choosen 
as "To" end point.

Table 3-8 Internal Patchcord Ports

Card OCH Trunk Port OTS/OCH Port OCH Filter Port

TXP, MXP, GE_XP, 
10GE_XP, ADM-10G or 
ITU-T line card

Any trunk port — —

OPT-BST — COM RX

COM TX

LINE RX

LINE TX

—

OPT-AMP-17-C — COM RX

COM TX

LINE RX

LINE TX

—

OPT-AMP-C — COM RX

COM TX

LINE RX

LINE TX

—

OPT-PRE — COM RX

OSC-CSM — COM RX

COM TX

LINE RX

LINE TX

—
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Step 4 Click Next.

Step 5 On the Internal Patchcord Creation page, provision the internal patchcord origination parameters.

• Shelf—(multishelf nodes only) Choose the shelf where the internal patchcord originates.

• Slot—Choose the slot containing the card where the internal patchcord originates. Refer to 
Table 3-8 for a list of cards that are available, based on the patchcord type chosen in Step 3.

• Port—Choose the TX port where the internal patchcord originates.

Step 6 Click Next.

Step 7 In the Internal Patchcord Termination page, provision the internal patchcord termination parameters.

• Shelf—(multishelf nodes only) Choose the shelf where the internal patchcord terminates.

• Slot—Choose the slot containing the card where the internal patchcord terminates. Refer to 
Table 3-8 for a list of cards that are available, based on the patchcord type chosen in Step 3.

• Port—Choose the TX port where the internal patchcord terminates.

Step 8 Click Next. If you chose the OTS/OCH to OTS/OCH patchcord type Step 3 and did not choose 
bidirectional, continue with Step 12. Otherwise, continue with the next step.

Step 9 Review the display-only information on the Internal Patchcord Origination Reverse page. This page 
shows the shelf (multishelf nodes only), slot, and port that CTC will use for the opposite internal 
patchcord origination route.

Step 10 Click Next.

Step 11 Review the information displayed on the Internal Patchcord Termination Reverse page. This 
display-only page shows the shelf (multishelf nodes only), slot, and port that CTC will use for the reverse 
internal patchcord termination route.

Step 12 Click Finish. The new internal patchcord appears on the Internal Patchcord table.

Step 13 Return to your originating procedure (NTP).

32MUX/40-MUX-C — COM TX Any CHAN RX port

32DMX/
40-DMX-C or 40-DMX-CE

— COM RX Any CHAN TX port

32WSS/
40-WSS-C or 40-WSS-CE

— COM RX

COM TX

Any ADD or PT port

40-WXC-C — COM RX

COM TX

—

AD-1C-xx.x

AD-1B-xx.x

4MX-xx.x

— COM RX

COM TX

—

Table 3-8 Internal Patchcord Ports

Card OCH Trunk Port OTS/OCH Port OCH Filter Port
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DLP-G355 Delete an Internal Patchcord 

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Internal Patchcord tabs.

Step 2 Click the connection you want to delete.

Step 3 Click Delete, then click Yes.

Step 4 Return to your originating procedure (NTP).

NTP-G209 Create, Edit, and Delete Optical Sides

Note For any node type including mesh nodes, the association between the shelf, linecard and side is reported 
in the left top window of CTC (Vital Status Pane) in the mode view.

Note For mesh nodes, the association between sides and the 40-WXC-C cards can be found in the 
Maintenance > DWDM > Mesh Patch Panel Internal Patchcords screen. 
For example:
PP-MESH, LC (A): Shelf 1, Slot 3 (40 WXC), port EXP-TX
PP-MESH, MPO (A): Shelf 1, Slot 3 (40 WXC), port EXP-RX
The above rows indicate that the: 
WXC port located in Shelf 1, Slot 3 is connected to the LC connector A (Side A) on PP-MESH.
WXC port located in Shelf 1, Slot 3 is connected to the MPO connector A (Side A) on PP-MESH.

Purpose This task deletes an internal patchcord.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This procedure allows you to create, edit, and delete optical sides on a 
DWDM node.

Tools/Equipment None

Prerequisite Procedures NTP-G143 Import the Cisco TransportPlanner NE Update Configuration 
File, page 3-43

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to provision the 
optical side. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the following tasks:

• Complete the “DLP-G491 Create an Optical Side” task on page 3-103.

• Complete the“DLP-G492 Edit an Optical Side” task on page 3-103.

• Complete the “DLP-G480 Delete an Optical Side” task on page 3-104.

Stop. You have completed this procedure.

DLP-G491 Create an Optical Side

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Optical Sides tabs.

Step 2 Click Create.

Step 3 In the Create Side dialog box, enter the following:

• Side ID—Choose a side ID (A, B,C, D, E, F, G, or H) from the drop-down list.

• Line In—Choose an RX port from the drop-down list.

• Line Out—Choose a TX port from the drop-down list.

Step 4 Return to your originating procedure (NTP).

DLP-G492 Edit an Optical Side

Purpose This task creates an optical side. For more details on optical sides, refer to 
the Node Reference chapter in the Cisco ONS 15454 DWDM Reference 
Manual.

Tools/Equipment None

Prerequisite Procedures “DLP-G46 Log into CTC” task on page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task edits the side ID of an optical side.

Tools/Equipment None

Prerequisite Procedures “DLP-G46 Log into CTC” task on page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Optical Sides tabs.

Step 2 Click the optical side you want to edit.

Step 3 Click Edit.

Step 4 In the Edit Side ID dialog box, choose a side ID (A, B,C, D, E, F, G, or H) from the drop-down list.

Step 5 Click OK.

Step 6 Return to your originating procedure (NTP).

DLP-G480 Delete an Optical Side

Step 1 In node view (single-shelf mode) or multishelf view (multishelf mode), click Provisioning > 
WDM-ANS > Optical Sides tabs.

Step 2 Click the optical side you want to delete.

Step 3 Click Delete

Step 4 In the confirmation dialog box, click Yes to continue.

Step 5 Return to your originating procedure (NTP).

Purpose This task deletes an optical side.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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NTP-G38 Provision OSC Terminations

Note The DCCs, GCCs, and OSCs should not be provisioned between SONET (ANSI) and SDH (ETSI) nodes 
using CTC or TL1 because they cannot operate between SONET and SDH nodes. These communication 
channels should be provisioned on similar nodes, such as SONET-to-SONET or SDH-to-SDH.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to provision the 
OSC terminations. If you are already logged in, continue with Step 2.

Step 2 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > 
Comm Channels > OSC tabs.

Step 3 In the OSC Terminations area, click Create (Figure 3-28).

Purpose This procedure provisions the OSC terminations. The OSC provides a 
bidirectional channel that connects all nodes within a DWDM ring. The 
OSC carries a supervisory data channel and synchronizes clocking at 
network nodes. The OSC also carries a user data channel.

Tools/Equipment None

Prerequisite Procedures NTP-G143 Import the Cisco TransportPlanner NE Update Configuration 
File, page 3-43

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Figure 3-28 OSC Terminations Area

Step 4 In the Create OSC Terminations dialog box, choose the ports where you want to create the OSC 
termination. To select more than one port, press the Shift key (to select a range of ports) or the Ctrl key 
(to select multiple individual ports).

Note The number of OSC terminations that you create depends on the node type defined by 
Cisco TransportPlanner. Terminal nodes require one OSC termination. Hub, OADM, and 
ROADM nodes require two OSC terminations.

Step 5 In the Layer 3 area, check the OSI box if the following conditions are met:

• The OSC termination is between the ONS 15454 and another ONS node.

• Third party NEs that use the OSI protocol stack are on the same network. 

If you checked OSI, complete the following steps. If not, continue with Step 6.

a. Click Next.

15
98

23

Comm Channels
tab

Provisioning
tab

Create OSC Terminations
dialog box
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b. Provision the following fields:

• Router—Choose the OSI router.

• ESH—Set the ESH propagation frequency. End system NEs transmit ESHs to inform other ESs 
and ISs about the NSAPs they serve. The default is 10 seconds. The range is 10 to 1000 seconds.

• ISH—Sets the ISH PDU propagation frequency. Intermediate system NEs send ISHs to other 
ESs and ISs to inform them about the IS NETs it serves. The default is 10 seconds. The range 
is 10 to 1000 seconds.

• IIH—Sets the IIH PDU propagation frequency. The IS-IS Hello PDUs establish and maintain 
adjacencies between ISs. The default is 3 seconds. The range is 1 to 600 seconds.

• Metric—Sets the cost for sending packets on the LAN subnet. The IS-IS protocol uses the cost 
to calculate the shortest routing path. The default metric cost for LAN subnets is 20. It normally 
should not be changed.

Step 6 Click Finish. Ports are automatically placed in service. The following alarms might appear in the node 
view (single-shelf mode) or multishelf view (multishelf mode) Alarms tab Description field. They will 
remain until all the network OSC connections between the adjacent nodes are created:

• SDCC Termination Failure (ANSI) or RS-DCC Termination Failure (ETSI) on the OSCM or 
OSC-CSM card

• LOS on the OC-3 port (Port 1) on the OSCM, OSC-CSM, or OPT-BST card

• OPWR-LFAIL on the OPT-BST or OSC-CSM card

Note After the OSC termination is created, the line ports are placed in service and span power levels 
are checked.

Stop. You have completed this procedure.
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NTP-G37 Run Automatic Node Setup

Note If you are provisioning ANS parameters that were not calculated using Cisco TransportPlanner, do not 
complete this procedure until after you complete the “NTP-G169 Calculate ANS Installation Values for 
Installation Without Cisco TransportPlanner” procedure on page B-5.

Note Provisioning ANS may impact traffic under the following conditions:

• when Input FailThreshold is set to high for OPT-PRE

• when wrong threshold values are set on OSC or BST/OSC-CSM

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to run ANS. If 
you are already logged in, continue with Step 2.

Step 2 Referring to the Cisco TransportPlanner Installation Parameters (see Table 3-1 on page 3-3), identify the 
parameters that have a Yes in the Manually Set column. If there are no parameters that have a Yes in the 
Manually Set column, continue with Step 6.

Step 3 In CTC, display the card where the parameter is to be manually provisioned in card view.

Step 4 Enter the specified Calibration parameter from the Cisco TransportPlanner Installation Parameters table. 
Click Apply.

Step 5 Repeat Steps 2 through 4 for each parameter in the Cisco TransportPlanner Installation Parameters table 
that displays Yes in the Manually Set field.

Step 6 Change to node view (single-shelf mode) or multishelf view (multishelf mode).

Step 7 Click the Provisioning > WDM-ANS > Port Status tabs. 

Purpose This procedure runs the Launch ANS function. Launch ANS applies the 
ANS parameters (calculated in the “NTP-G143 Import the Cisco 
TransportPlanner NE Update Configuration File” procedure on page 3-43 
or the “NTP-G169 Calculate ANS Installation Values for Installation 
Without Cisco TransportPlanner” procedure on page B-5) to the node and 
to the ports for cards installed in the node. The applied ANS parameters 
include span loss values, threshold values, power references, and others. 
Launch ANS also sets the VOA references based on the calculated power 
references.

Tools/Equipment The Cisco TransportPlanner Installation Parameters file

Prerequisite Procedures NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

NTP-G30 Install the DWDM Cards, page 3-54

NTP-G152 Create and Verify Internal Patchcords, page 3-98

NTP-G143 Import the Cisco TransportPlanner NE Update Configuration 
File, page 3-43

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 8 Click Launch ANS. 

Step 9 In the Apply Launch ANS dialog box, click Yes. 

Step 10 In the Launch ANS confirmation dialog box, click OK. 

Step 11 Verify that one of the following statuses appears in the Link Status column for all ports:

• Success - Changed—The parameter setpoint was recalculated successfully.

• Success - Unchanged—The parameter setpoint did not need recalculation.

• Not Applicable—The parameter setpoint does not apply to this node type.

If one of the following statuses is shown, complete the provided instructions:

• Fail - Out of Range—The calculated setpoint is outside the expected range. If this status appears, do 
not continue until you have investigated and cleared the cause. This status might appear because of 
an error in the Cisco TransportPlanner file. It could also appear because the insertion loss of the 
installed cards is greater than the estimated insertion loss calculated by Cisco TransportPlanner. If 
so, the Cisco TransportPlanner file will need to be recalculated. If the installation without Cisco 
TransportPlanner function is being used, an error could have occurred in the retrieval of values from 
the far-end nodes. The error could be caused by an incorrect CTC calculation, or by an incorrect 
manual calculation. All of these possible causes should be investigated. Contact your next level of 
support if you are unable to clear this status.

• Fail - Port in IS State—The parameter could not be calculated because the port is in service. This 
status should normally not appear at this point in node turn-up. If it does, display the card in card 
view, change the port administrative state to OOS,DSLB (ANSI) or Locked,disabled (ETSI), and 
repeat Steps 6 through 11. 

Note If the ports that are in service carry circuits, you must delete the circuits before you can place 
the ports out of service. See the “DLP-G347 Delete Optical Channel Client Connections” task 
on page 7-10, the “DLP-G418 Delete an Optical Channel Trail” task on page 7-18, or the 
“DLP-G106 Delete Optical Channel Network Connections” task on page 7-23.

Stop. You have completed this procedure.

NTP-G39 Verify OSCM Transmit Power

Note Throughout this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Purpose This procedure verifies that the transmit power for the ONS 15454 OSCM 
and the OSC-CSM cards is correct.

Tools/Equipment None

Prerequisite Procedures NTP-G37 Run Automatic Node Setup, page 3-108

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you want to verify the 
OSCM or OSC-CSM transmit power. If you are already logged in, continue with Step 2.

Step 2 Disable automatic laser shutdown (ALS) on Side A or (for terminal nodes) the terminal side OSCM or 
OSC-CSM card: 

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click the Side A or 
terminal-side OSCM or OSC-CSM card.

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Disable. 

d. Click Apply. Click Yes in the confirmation dialog box.

Step 3 If an OSC-CSM or OSCM card is installed on Side B, complete the following steps. If not, continue with 
Step 4.

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click the Side B 
OSCM or OSC-CSM card.

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Disable. 

d. Click Apply. Click Yes in the confirmation dialog box.

Step 4 Complete the “DLP-G314 Verify OSCM Transmit Power” task on page 3-111.

Step 5 Change ALS to Auto Restart on the Side A or (for terminal nodes) the terminal side OSCM or OSC-CSM 
card: 

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click the Side A or 
terminal-side OSCM or OSC-CSM card.

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Auto Restart. 

d. Click Apply. Click Yes in the confirmation dialog box.

Step 6 If an OSC-CSM or OSCM card is installed on Side B, complete the following steps. If not, you have 
completed this procedure.

a. In the node view (single-shelf mode) or shelf view (multishelf mode), double-click Side B OSCM 
or OSC-CSM card.

b. Click the Maintenance > ALS tabs.

c. From the ALS Mode drop-down list, choose Auto Restart. 

d. Click Apply. Click Yes in the confirmation dialog box.

Stop. You have completed this procedure.
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DLP-G314 Verify OSCM Transmit Power

Step 1 Display the OSCM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Record the Port 3 (OSC TX) Power value: _____.

Step 4 Change to node view (single-shelf mode) or multishelf view (multishelf mode), then click the 
Provisioning > WDM-ANS > Provisioning tabs.

Step 5 Record the OSC Power value under the OSCM card in the tree view.

Step 6 If the power value recorded in Step 3 is not within the range of +/– 0.5 dBm recorded in Step 5, complete 
the following steps. Otherwise, continue with Step 7.

a. Click the Maintenance > ALS tabs. Verify that the ALS Command is set to OSRI Off. If not, choose 
Off from the drop-down list. Click Apply, then click Yes.

b. Clean the optical connections. See the “NTP-G115 Clean Fiber Connectors” procedure on 
page 13-26.

c. Complete the following procedures:

• Delete the two OSC channels using the “DLP-G186 Delete an OSC Termination” task on 
page 10-47.

• Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-108.

• Create the OSC channels using the “NTP-G38 Provision OSC Terminations” procedure on 
page 3-105.

d. Repeat Step 3 through 6. If the power level is still not within the specified range, contact your next 
level of support.

Step 7 Return to your originating procedure (NTP).

Purpose This task verifies that the transmit power of the OSCM card is correct.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser only
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NTP-G163 Upgrade Nodes in Single-Shelf Mode to Multishelf 
Mode

Caution An optical shelf in a multishelf configuration must be provisioned as the node controller shelf and not a 
subtending shelf, otherwise traffic will be dropped. If no slots are available on an optical shelf to install 
the MS-ISC-100T cards needed for a node controller shelf, install and configure the Cisco Catalyst 2950. 
See the “NTP-G158 Connect a Multishelf Node and Subtending Shelves to a Catalyst 2950” procedure 
on page 1-85.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node that you want to configure as a 
multishelf node.

Step 2 If you want to configure a shelf as the node controller, continue with Step 3. If you want to configure a 
shelf as a subtending shelf, continue with Step 4. 

Step 3 To set up the login node as the node controller, complete the following steps:

a. In node view (single-node mode) or multishelf view (multishelf mode), click the Provisioning > 
General > Multishelf Config tabs.

b. Click Enable as Node Controller. 

c. From the LAN Config drop-down list, complete one of the following:

• Choose Ethernet Switch if MS-ISC-100T cards or the Catalyst 2950 switches are already 
installed and configured.

• Choose Stand-Alone if MS-ISC-100T cards are not installed yet but will be in the final layout 
or if this is a line amplifier or an OSC-only site. This option will allow a safe migration of the 
TCC2/TCC2P database when the multishelf configuration is complete. 

d. Click Apply.

Purpose This procedure upgrades nodes in single-shelf mode to multishelf mode.

Tools/Equipment The node you plan to use as the node controller must be equipped with 
optical units and cannot have a cross-connect card installed. Any nodes 
that you plan to add to the multishelf configuration as subtending shelves 
can be equipped with transponder and muxponder units. For more 
information on multishelf configurations, see the “Node Reference” 
chapter in the Cisco ONS 15454 DWDM Reference Manual.

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-5

One of the following procedures:

• NTP-G145 Connect a Multishelf Node and Subtending Shelves to an 
MS-ISC-100T Card, page 1-82, or

• NTP-G158 Connect a Multishelf Node and Subtending Shelves to a 
Catalyst 2950, page 1-85

Required/As Needed As needed

Onsite/Remote Onsite 

Security Level Superuser only
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e. In the confirmation dialog box, click Yes to allow the node to reboot. The CTC view changes to 
network view and the node icon changes to gray. Wait for the reboot to finish. (This might take 
several minutes.) 

f. After the node reboots, double-click the node. The multishelf view appears.

Note The shelf ID of the node controller is automatically assigned as 1.

Step 4 To add a node as a subtending shelf in the multishelf configuration, complete the following:

a. In multishelf view, right-click in the white space in the rack and choose Add Shelf.

b. In the Shelf ID Selection dialog box, choose a shelf ID (from 2 to 8) from the drop-down list. 

c. Click OK. The shelf appears in the multishelf view.

d. Preprovision the new shelf so that it has the same provisioning as the actual shelf that you will add 
as the subtending shelf:

Caution If the subtending shelf is not preprovisioned, traffic will be lost.

• Cards, PPMs, administrative states, client and trunk port configuration—For more information 
on card and port settings, see Chapter 5, “Provision Transponder and Muxponder Cards.”

• Timing—For more information, see the “NTP-G53 Set Up Timing” procedure on page 6-4.

• GCC—For more information, see the “DLP-G76 Provision DCC/GCC Terminations” task on 
page 7-58.

e. Disconnect the cross-over (CAT-5) LAN cable from the RJ-45 (LAN) port of the subtending shelf 
TCC2/TCC2P card in Slot 11.

f. Connect your Windows PC or Solaris workstation NIC to the RJ-45 (LAN) port on the TTC2/TCC2P 
card in Slot 11.

g. Complete the “DLP-G46 Log into CTC” task on page 2-26 at the subtending shelf.

h. Click the Provisioning > General > Multishelf Config tabs.

i. Click Enable as Subtended Shelf. 

j. From the Shelf ID drop-down list, choose the shelf ID that you created in Step b.

k. Click Apply. 

l. In the confirmation dialog box, click Yes to reboot the shelf. The CTC view changes to network view 
and the node icon changes to gray. Wait for the reboot to finish. (This might take several minutes.) 

m. Disconnect your Windows PC or Solaris workstation network interface card (NIC) from the RJ-45 
(LAN) port of the subtending shelf TTC2/TCC2P card in Slot 11.

n. Reconnect the cross-over (CAT-5) LAN cable (disconnected in Step e) to the RJ-45 (LAN) port of 
the subtending shelf TCC2/TCC2P card in Slot 11.

Note The Ethernet cable must be connected to the subtended shelf TCC2/TCC2P cardsoon after 
this TCC2/TCC2P card completes its boot phase (when it becomes active and its peer 
TCC2/TCC2P card starts rebooting). Connecting it before the TCC2/TCC2P card completes 
its boot phase is a risk in the conversion process. Connecting it long time after completion 
of the boot phase might affect traffic due to missing provisioning.
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o. Repeat Steps a through n to set up additional subtending shelves.

Note Cisco Transport Manager (CTM) users can use the CTM NE Explorer to monitor and configure 
single-shelf and multishelf nodes. When the upgrade is complete, the original individual 
subtending shelves will remain the CTM network view and must be manually deleted. For 
detailed information, refer to the Cisco Transport Manager User Guide, Appendix B, “NE 
Explorer Information.”

Stop. You have completed this procedure.
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